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1. Wireless Sensor Network Overview

The LORD MicroStrain ® Wireless Sensor Network is a high- speed, scalable, sensor data
acquisition and sensor networking system.  Each system consists of wireless sensor interface
nodes, a data collection gateway, and full-featured user software platforms based on the LORD
MicroStrain® Lossless Extended Range Synchronized (LXRS®) data communications protocol. 
Bidirectional wireless communication between the node and gateway enables sensor data
collection and configuration from up to two kilometers away. Gateways can be connected locally to
a host computer or remotely via local and mobile networks. Some gateways also feature analog
outputs for porting sensor data directly to standalone data acquisition equipment.

The selection of available nodes allows interface with many types of sensors, including
accelerometers, strain gauges, pressure transducers, load cells, torque and vibration sensors,
magnetometers, 4 to 20mA sensors, thermocouples, RTD sensors, soil moisture and humidity
sensors, inclinometers, and orientation and displacement sensors. Some nodes come with
integrated sensing devices such as accelerometers. System sampling capabilities are IEEE
802.15.4-compliant and include lossless synchronized sampling, continuous and periodic burst
sampling, and data logging. A single gateway can coordinatemany nodes of any type, andmultiple
gateways can be managed from one computer with the Node Commander® and SensorCloud™
software platforms. Integration to customer systems can be accomplished using OEM versions of
the sensor nodes and leveraging the LORD MicroStrain® data communications protocol.

Common wireless applications of LORD MicroStrain® Sensing Systems are strain sensor
measurement, accelerometer platforms, vibration monitoring, energy monitoring, environmental
monitoring, and temperaturemonitoring.
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2. Software Overview

Node Commander® is a full featured data acquisition tool designed for use with the LORD
MicroStrain®Wireless Sensor Network. Node Commander® is included with all gateway devices
and is used for gateway and node configuration, and data collection tasks. It includes settings for
node and gateway communications, power management, sensor type and output parameters,
sensor sampling rates and modes, and data handling and storage. There are also interactive
features that aid in field installation, such as node discovery, transmission range tests, sensor
calibration routines, and near real time sensor data display. Node Commander® manages
configuration and data collection of multiple gateways and nodes simultaneously, including
synchronized samplingmodes.

Node Commander® is designed for use with all LORD MicroStrain® gateways and nodes, and
runs on most Windows® platforms. Included with all Node Commander® distributions is an
auxiliary program called Live Connect™. Live Connect™ is used to translate between the Node
Commander® serial protocol and the TCP/IP protocol used for Ethernet gateways. Another
auxiliary program,WSDA®Data Downloader is included for uploading data saved in theWSDA®

-1500 - LXRS® gateway on-boardmemory.

Figure 1 - Node Commander® Software
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2.1 Navigation and Views

TheNode Commander® user interface includes a status bar, an icon toolbar, a header row of
drop downmenus, devicemenus, and three main information windows, as shown in Figure 2 -
User Interface . When the software is first launched, only the Controller and Action Log
windows are shown. The Sampling windows appear only when sampling is initiated and vary
depending on the type of sampling being performed. The device menus are accessible only
when the devices, such as gateways and nodes, are connected and communicating with Node
Commander® . They are accessed by right clicking on the device name in the Controller
window.

Figure 2 - User Interface

Windows can be repositioned by selecting the window header bar and dragging and dropping it
in the desired location. Outline guides will appear when the item is dragged to a new position.
Windows can also be closed or minimized with the icons in the upper right corners or with the
header row View menu. The header row can be repositioned in the sameway but not closed.

In all menus only the commands that are currently available are selectable. They are shown in
color and will appear highlighted when hovered over. Some icons and selections will display
feature or device details as well. Features that are not available will be gray. Available
commands are dependent on what devices are connected and what tasks the software and
system are currently executing.
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l CONTROLLER INFORMATION WINDOW – The Controller information window displays
a list of all attached, or previously attached, devices. The devices are organized in a
hierarchical tree and display the gateways and corresponding node names and addresses.
Additional node information can be viewed by selecting the “+” symbol next to the node
name. Inactive devices can be removed from the list through the devicemenu.

l HEADER ROW MENUS - includes the program level commands in Node Commander® ,
such as file management and view settings.

l DEVICE MENUS – such as the gateway and nodemenus are accessed by right clicking on
the device name in the Controller window. All actions available for the particular device can
be found in its menu and will vary between device types. Settings will only be applied to the
selected device.

l ICON TOOLBAR – provides quick access to themost common commands.

l ACTION LOG – displays command execution information, including errors. For example,
the action log will display confirmation of device verification and an error if it cannot be
verified when requested. Information about configuration, testing, and sampling tasks are
also displayed after commands are executed. Refer to the log to determine the current
status of the system.

l STATUS BAR – displays the Node Commander® program status. This menu can be
hidden using the header row View menu.

l SAMPLINGWINDOW – displays the data being acquired from actively sampling node. The
sampling window is only displayed when sampling has been activated, and the display
varies depending on the sampling mode. Some modes include a graph view and a data
view, while others include only one.

NOTE

Available menu and configurations options in Node Commander® are dependent on
the devices connected. This manual provides information on all possible menus.
Refer to the device manual and specifications to determine what menus and options
are applicable.
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2.2 Software Installation

To install Node Commander ® Software Suite  on the host computer, run the installer
executable file and follow the on-screen prompts. The software is provided with all gateways
and is available on the LORD MicroStrain®website (see References on page 130).

NOTE

The Node Commander® software includes hardware drivers required for use with
USB gateways.  Once installed, the software will automatically detect and configure
anyUSB gateways that are plugged into the host computer.

The suite includes the following programs:

l Node Commander is used for configuring nodes and acquiring, viewing, and
saving data. 

l Live Connect™ is a TCP/IP-to-serial conversion tool that translates the
communications between Node Commander and an Ethernet gateway.

l WSDA® Data Downloader is used to download acquired data from the flash
memory card embedded in an applicable gateway, to a host computer.

SensorCloud™ is an optional data collection, visualization, analysis, and remote
management tool. It is based on cloud computing technology and is accessed directly from a
web connection. For more information see Data Handling on page 23.
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2.3 Software Preferences

The Preferences menu is used to configure basic software operational features such as the
default data directory, disk space allocation for data, and device and graphing preferences.

NOTE

To avoid filling the computer memory in high sample rate or data intensive
applications, use theMinimumDisk Space Required to Collect Data setting to limit the
total file space allocation. Once the limit is reached data will no longer be saved on the
computer, however, the nodes may continue to sample and transmit data. In
synchronized sampling mode the beacon will be turned off and (depending on
configuration) will either go into sleep mode or continue to sample without
synchronization. In low duty cycle sampling the node will continue to sample.

To access themenu, click on the Edit header and select Preferences.

Figure 3 - Software Preferences
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3. System Operational Overview

To acquire sensor data, nodes are used with any LORD MicroStrain® data gateway, such as the
WSDA® -Base -10x -LXRS® or WSDA® -1500 - LXRS®, and a software interface.

LORD MicroStrain® has two software programs available for data acquisition from the wireless
sensor network: SensorCloud™ and Node Commander®.  SensorCloud™ is an optional web-
based data collection, visualization, analysis, and remote management platform based on cloud
computing technology. Node Commander® is used for configuring gateways and nodes, selecting
samplingmodes and parameters, initializing data acquisition, and viewing and saving data.

The operational overview describes system hardware and software setup, and the basic
navigation of Node Commander® used to configure the node and begin data acquisition.  A brief
overview of porting data to SensorCloud™ is also included. This section is included as a quick start
guide and is not a complete demonstration of all system and software capabilities.
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3.1 System Connections

To acquire sensor data the following components are needed: a LORD MicroStrain® data
gateway and a local or networked host computer with access to the data acquisition software.
For a connections overview refer to Figure 4 - SystemConnections .

The sensor, node, gateway, and software selection are application-dependent, but the basic
interfaces are the same.  The WSDA® -Base -10x -LXRS® gateway utilizes local serial
connections to the host computer, such as RS232 and USB, and interfaces with the Node
Commander® software. Gateways with analog outputs can be connected directly to stand-
alone data acquisition devices for data collection, however system configuration will still occur
through a USB interface to Node Commander®.

Users can also write custom programs by utilizing the LORD MicroStrain®Wireless Sensors
Network Software Development Kit (see References on page 130).

Figure 4 - System Connections
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3.2 Gateway USB Communication

1. Power is applied to the gateway through the USB connection. Verify the gateway
status indicator is illuminated, showing the gateway is connected and on.

2. Open the Node Commander software.

3. The gateway should appear in the Controller window automatically with a
communication port assignment (Figure 5 - USB GatewayCommunication). If it is not
automatically discovered, verify the port is active on the host computer, and then
remove and re-insert the USB connector.

Figure 5 - USB Gateway Communication
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3.3 Connect to Nodes

Several methods can be used in Node Commander® to establish communication with the
nodes. This quick start section covers the two simplest methods; adding a node by address and
by using the node discovery feature.

3.3.1 Adding a Node by Address

Adding a node by address requires the node to be on the same communication frequency
as the gateway. The node address and frequency are indicated in the documentation
included with the node when it is purchased.

1. To add a node by address, right-click on the gateway name in the Controller window,
and select Add Node > Add Single Node (Figure 6 - Adding a Node by Address).

2. The node address and frequency are indicated in the documentation included with
the node. Enter the node address, and select OK. If the node is not found, amessage
will appear and provide the option to scan for the node on other frequencies.
Alternately, the Node Discovery feature can be used.

Figure 6 - Adding a Node by Address



Node Commander® Software Suite UserManual System Operational Overview

17

3.3.2 Using Node Discovery

The Node Discovery feature allows connection between the gateway and node to occur
even if they are on different frequencies. To connect to nodes using node discovery, begin
bymaking sure the node is powered off.

NOTE

Automatic node discoverymay not work in some boot-up modes. If the node is
not in normal boot upmode, the assigned one can be bypassed to enable node
discovery. For more information see Troubleshooting Guide on page 118.

1. Right-click on the gateway name and select Add Node > Node Discovery (Figure 7 -
Using Node Discovery).

2. Using the power switch, turn on the node. Within a few seconds, the node will
transmit a message with its operating frequency.

3. When the device status indicator on the node ends the rapid flash sequence and
begins pulsing at one-second intervals, the node has completed the normal boot-up
sequence and is running in idle mode. At this point the node should be listed in the
Controller window; scanning can be stopped by selecting the Stop button in the Node
Discovery window.

Figure 7 - Using Node Discovery
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3.4 Channel Configuration

The sensor settings are stored in the node memory, and each sensor is assigned a
corresponding channel number. The configuration menus will only show the channels and
configuration options that are available for the type of node being used.

1. To enter the configurationmenu, right-click on the node name, and select Configure >
Configure Node. The Channels tab displays channel options available for the node.

a. Channel Enabled: indicates the sensor channel number. The check box
is used to enable the channel and select it for sampling. The icon next to
the check box describes the channel type inherent to the node being used.
In the following example (Figure 8 - Node Channels Menu): a1) analog
differential channel icon, a2) analog single ended channel icon, and a3)
temperature channel icon.

b. Current channel configuration: The Data Output, Units, Input Range,
and Label fields describe how the channel is currently configured.

c. Configure: TheConfigure button changes the channel parameters, such
as measurement units, gain and offset settings, and calibration
values. The channel must be enabled first by selecting the adjacent check
box.

Figure 8 - Node Channels Menu
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2. To enter the channel configuration menu, select the Configure button as shown in
Figure 8 - Node ChannelsMenu.

a. Channel Label: names the channel

b. Channel diagram: shows channel electronics and data flow

c. Conversion Coefficients: defines the type and units of the
measurement beingmade

d. PGA Settings: These settings determine what gain is applied to the
sensor measurement and set the position of the no- load baseline
measurement for the sensor signal. It is only available for differential input
channels with gain amplifiers.

e. Calibration values: includes the slope, offset, scale, and formula used to
convert the sensor reading to engineering units. The slope and offset can
be determined from the sensor manufacturer calibration data or through a
calibration process.

Figure 9 - Channel Setup
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3.5 Sampling Settings

Sampling settings are accessed through the Configure Node menu. There is a tab for each
sampling mode available for the particular node ( Figure 10 - Sample Settings
Menu).Depending on the type of node, up to four samplingmodes are available: Synchronized
Sampling, Low Duty Cycle, Streaming, and Datalogging. Some modes have user-configurable
settings for sample rate, sample duration, and datalogging . Other settings are automatic,
depending on number of active channels and other variables. For more information on
samplingmodes, refer to the Node Commander user manual (see References on page 130).

Figure 10 - Sample Settings Menu

In general, when determining what sample mode and rate is most suitable for the application,
refer to the following guidelines;

l Use a sample rate at least twice the value of the target measurement frequency. This is the
minimum sample rate required to produce an accurate digital representation of the
measured signal. The higher the sample rate, themore accurate the digital representation.

l Using the minimum required sample rate will increase battery life and minimize the
allocated network bandwidth.

l Using periodic burst sampling in place of continuous sampling will increase battery life, and
the longer the sample interval, themore power and network bandwidth will be saved.

For synchronized sampling, use the online calculator to evaluate network bandwidth at different
sampling settings :

http://www.microstrain.com/configure-your-system

http://www.microstrain.com/configure-your-system
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3.6 Data Acquisition

NOTE

Touching sensors and test boards or charging the node battery while acquiring
datamay induce noise on sensitive sensor signals and is not recommended.

When data acquisition is started, each of the samplingmodes has different menu options
and views. Some have a settings menu that opens before data acquisition begins, and
may include a data list view and/or a graph view. The following is an example of
Synchronized Sampling (Figure 11 - Node Sampling Settings).

1. Right-click on the node (or nodes) name and then select Sample > Synchronized
Sampling.

2. In the Synchronized Sampling window select the destination folder for the data in
the Save Location field.

3. Select Apply Network Configuration, and then select Start Sampling.

Figure 11 - Node Sampling Settings

4. Close the Synchronized Sampling window by clicking the window X in the upper
right. The Sampled Data window is behind it. The default view is the Data Grid
view. Use the “+” symbol next to the node heading to view the data statistics.
Sampled data will appear in this window.
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NOTE

When synchronized sampling is set to slower sample rates it may take several
seconds after sampling is initiated for the first sample to appear.

Figure 12 - Sampling Data Grid View

5. Select Graph from the View Mode field, and then click on the node name to view a
graphical representation of the data.

6. To end sampling, close the Sampled Data window by clicking the X on the window
tab, and select Exit > Stop Nodes.

Figure 13 - Sampling Data Graph View
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3.7 Data Handling

Data acquired through Node Commander® is automatically saved on the host computer (see
Sensor Data Files on page 117) and can also be viewed from the web-based SensorCloud™
portal. Saved data can be uploaded to SensorCloud™ and Ethernet gateways provide the
option to automatically port the data to SensorCloud™ during data acquisition for near real-
time display and aggregation. Ethernet gateways can also be configured to save data locally to
internal memory for future upload to the host computer or SensorCloud™.

SensorCloud™ is based on cloud computing technology and is designed for long term
collecting and preservation of data. Features include time series and visualization graphing,
automated alerts, and data interpretation tools such as data filtering, statistical analysis, and
advanced algorithm development with the integrated MathEngine® interface. Leveraging the
open source API, SensorCloud™ can also be used to collect data from other LORD
MicroStrain® sensor products or third- party systems. Basic SensorCloud™ services are
available to all users free of charge (see Connecting to SensorCloud™ on page 24).

Figure 14 - Data Storage, Display and Processing
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3.7.1 Connecting to SensorCloud™

To connect to SensorCloud go to the SensorCloud website log-in page, and enter the log-in
credentials. Register as a new user if needed.

http://sensorcloud.com/log-in/

Figure 15 - SensorCloud™ Log-in or Register

The SensorCloud interface has six main views. When logging in as a registered user, the
Device view is the default. Navigate to other views by clicking the view name at the top of the
page (Figure 16 - SensorCloud™ Menu Views). The Data and Settings views are only
available once a device is selected from the device list.

Figure 16 - SensorCloud™ Menu Views

http://sensorcloud.com/login/
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Device - The device list shows every Ethernet gateway and API device associated with the
SensorCloud account, including owned, shared, and demo devices. This view provides links to
each device’s SensorCloud subscription plan, configuration options, and a summary of last
communications and data transactions.

Account - The account view is for logistic management of the SensorCloud account, such as
changing the log-in password, accessing user email, and reviewing billing information.

CSV Uploader - The data upload feature enables data from any source (such as non-Ethernet
LORD MicroStrain gateways, or third- party sensor) to be uploaded to the SensorCloud
platform. The datamust be in the LORD MicroStrain CSV format.

Data - This view is only available after a device is selected. It displays data that is collected
from sensor nodes or uploaded from files. Data selections are listed by node channel or a user-
defined label, and can be enabled for display in the graph window. The interactive graph has
navigational features such as panning, zooming, and an overview graph for single-click access
to data points or ranges. There are also use and management features such as viewing the
meta-data and downloading, embedding, and tagging data graphs.

Figure 17 - SensorCloud™ Data View

Settings - The settings view provides options for adding meta-data, configuring the data
displays for each channel, creating alerts based on data thresholds, setting the data timezone,
andmore.

MathEngine® - is used to analyze sensor data. Functions include the ability to filter out
frequencies, smooth out noisy data, performmath operations such as Fast Fourier Transforms
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(FFTs), and more (Figure 18 - MathEngine® View ) . MathEngine® interfaces with the
SensorCloud graphing view for faster processing. Users can write their own algorithms for
custom applications. Refer to theMathEngine®website for more information.

http://sensorcloud.com/mathengine

Figure 18 - MathEngine® View

Figure 19 - FFT Graph in SensorCloud™

For more information about SensorCloud features and navigation, refer to the SensorCloud
website or contact LORD MicroStrain Technical Support. 

http://sensorcloud.com

http://sensorcloud.com/mathengine
http://sensorcloud.com/mathengine
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3.7.2 Sensor Data Files

Data acquired in Node Commander is stored in .CSV format and can be opened with
Microsoft Excel, Quattro Pro, Open Office, or another CSV editors/spreadsheet program. 
Data in this format is easily uploaded to SensorCloud™ using the CSV Uploader. The data
files can be found on the host computer in the default directory or the location specified at
the beginning of the sampling session (as applicable). The files are organized in separate
folders bymode and then further categorized by date, session, and/or node serial number. 

The default directory is:C:\ProgramData\Microstrain\NodeCommander\Data

Synchronized sampling and low duty cycle files are found in the Sampled Data folder,
and streaming data is stored in the Streaming folder. Datalogging files need to be
downloaded from the node to be available for viewing. They are accessed through
datalogging menus as well as the File menu, and are saved in the Downloaded Triggers
folder.

Figure 20 - Exploring Data

NOTE

The Microsoft Excel the Time data column in the data file may have to be
changed to "m/d/yyyy h:mm:ss:000" format to make it more readable.
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4. Gateway Communication

When a gateway is communicating with the host computer in Node Commander® it will appear on
a list in the Controller window with a name that includes the communications port for which it is
configured and an icon symbolizing the type of communication interface.

Node Commander® remembers gateways and nodes that have been communicated with
previously. They will appear on the list when the software is started, however the name and icon
will be grayed out if the device is not currently communicating. To remove a gateway that is no
longer used, select Remove Base Station from the gatewaymenu.

Right clicking on the gateway name will produce a list of menu options available for the gateway .
Figure 21 - GatewayCommunication shows a USB gateway that is communicating on ComPort 3,
with the correspondingmenu and a serial gateway that is not connected.

Figure 21 - Gateway Communication

Some gateways will reconnect automatically when plugged into the host computer, while others
must be prompted to look for attached devices. To re-establish communication with a gateway on
the list, select Verify Base Station from the gateway menu. The Action Log window will display a
report on the success of the command.

To establish communication with a new device, or if the Verify Base Station command is
unsuccessful, refer to the following section that corresponds with the gateway communication
appropriate for themodel of gateway being used.
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4.1 Gateway Serial Communication

1. See See System Connections on page 14 . Make all hardware connections and
power on the gateway. Verify the gateway status indicator shows that it is on.

NOTE

If using a serial gateway and the computer does not have a serial port, a USB to
RS232 converter may be used. Install the converter drivers, as directed by the
manufacturer, and set the converter to match the gateway port settings.

1. Open the Node Commander® software

2. Right click anywhere in the Controller window, and select either Scan or Add Com
Port from themenu.

1. Scan Com Ports will attempt to find the connected device
automatically, and is useful if the port number is not known. Refer to
the Action Log window tomonitor the scan progress.

2. Add ComPorts can be used to assign the port number the gateway is
attached to. For information on communication port numbers and
settings in Windows®, see Communications Ports in Windows® on
page 123. If the name and icon are grayed out, the gateway has been
added but is not yet communicating.

Figure 22 - Scan or Add Com Port
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3. If using the Add Com Ports option, select the port that the gateway is connected to,
and then clickOK.

Figure 23 - Select Com Port

4. The gatewaywill now appear in the Controller window.

Figure 24 - Serial Gateway Communication
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4.2 Gateway USB Communication

1. Power is applied to the gateway through the USB connection. Verify the gateway
status indicator is illuminated, showing the gateway is connected and on.

2. Open the Node Commander software.

3. The gateway should appear in the Controller window automatically with a
communication port assignment (Figure 25 - USB Gateway Communication). If it is
not automatically discovered, verify the port is active on the host computer, and then
remove and re-insert the USB connector.

Figure 25 - USB Gateway Communication
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4.3 Gateway Ethernet Communications

NOTE

The default configuration of Ethernet gateways is for DHCP network
connectivity. In order to change the gateway communication settings initial
connection to a DHCP enabled network is required. Refer to the gateway user
manual for additional information (see Reference Information on page 130).

The gateway can be configured for the following Ethernet communication schemes:

l Automatically, through a DHCP-enabled local or wide area network.

l By assigning the gateway a static IP address and connecting it directly to a host
computer.

l By assigning the gateway a static IP address and connecting it to a similarly configured
network.

l By connecting remotely through the SensorCloud™ web interface .

4.3.1 Connecting to a DHCP Network with Live Connect™

The following steps describe how to establish communication with the Node
Commander® Software using Live Connect™.

1. Connect the host computer and gateway to the DHCP network and apply power to
the gateway. Verify the gateway status indicator shows that it is on and has
completed the boot up process.

2. Open Live Connect™. The gateway will be detected automatically but depending on
the network, it may take 2 to 3 minutes. Once detected, the gateway will appear on
the list of discovered devices and can be identified by its serial number in the Device
Name column (Figure 26 - Live Connect™ Interface).

3. When the gateway appears on the list, highlight it and click the Connect button. The
Status column will indicate when communication has been established, and if so, the
Port columnwill display the communications port. All active gateways on the network
will be displayed, and can be connected to in thismanner.
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NOTE

Once communication has been established, the gateway settings can be
adjusted through the gateway Control Panel. Access Control Panel by
highlighting the gateway and selecting the View button in Live Connect™.

Figure 26 - Live Connect™ Interface

4. Open Node Commander®.

5. The gateway will appear in the Controller window automatically with a
communication port assignment.

Figure 27 - Ethernet Gateway Communication
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4.4 Verify Gateway Communication

The Verify and Reverify Base Station commands can be used to check the communication
status of the gateway to the host computer. The Verify command is available in the gateway
menu if no communication has been previously established. The Reverify command is in the
gatewaymenu if communication has already be established, and it is used to check the current
status. Right-click on the gateway name, and select the command. The Action Log will report
the results of the gateway query.

Figure 28 - Verify Gateway Communication

4.5 Gateway Communication Timeout

NodeCommander®will attempt to establish communication with the gateway for the amount of
time set as the communication timeout; the default setting is 20 milliseconds. If communication
cannot be established, try adjusting this value for a longer timeout. Right-click on the gateway
name, and select Configure > Configure Timeout. Adjust the value, and then select the Test
Value button to test the communication to the gateway (Figure 29 - Communication Timeout).
This feature can also be used if communication to the node is intermittent.

Figure 29 - Communication Timeout
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4.6 Removing a Gateway

To remove a gateway that is no longer used, right-click on the gateway name in the Controller
window, and select Remove Base Station from the gatewaymenu .

Figure 30 - Removing Gateways
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5. Gateway Settings

5.1 Gateway Information

Gateway information (such as the model type, serial number, radio type, operating frequency,
current communications port, and firmware revision) is found in the gateway Information
window. Right-click on the gateway name and select Configure > Configure Base Station.

There is also a Label field to give the gateway a unique name, which is useful when there are
multiple gateways in the system. Gateway transmit power can also be selected in this window.
For additional information see Transmit Power on page 38.

Figure 31 - Gateway Information and Name
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5.2 Transmit Frequency

The transmit frequency of the wireless sensor network refers to the communication link
between the gateway and the node. There are 14 available frequency channels between 2.405
and 2.470GHz.

NOTE

l The gateway can automatically manage nodes operating on different frequencies
by using the Node Discovery feature in Node Commander®. In this routine, the
gateway listens for node broadcasts on the frequency channel to which it is set. If
the node is in normal boot-up mode, it will provide the broadcast when it is initially
powered-on, and it will broadcast on all channels. As long as the node is powered-
on after activating the Node Discovery feature, the gateway will link to it and
remember the channel setting for future node queries.

l Manually matching the node and gateway frequency channels is required in some
applications. For example, when sending broadcast messages from the gateway to
multiple nodes (including the synchronized sampling beacon) all nodes must be on
the same channel as the gateway in order to receive the broadcast. Assigning
channels is also a good idea when multiple gateways are attached to one host
computer or when other wireless equipment is nearby and frequency or
transmission interferencemay occur.

The frequency setting for the gateway can be changed from the Configuremenu.

Figure 32 - Gateway Frequency
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5.3 Transmit Power

The transmit power level may require adjustment if power consumption is a concern or in
regionswhere there are transmit power restrictions. Lowering the power output reduces power
consumption, but it also reduces the wireless communication range between the gateways and
nodes.

NOTE

Actual range is highly dependent of how the nodes and gateways are installed and the
conditions in the surrounding environment (see Range Test on page 56).

Setting Power Output
Maximum
Range

Extended 16 dBm (39mW) 2 km
Standard 10dBm (10mW) 1 km
Low 0dBm (1mW) 70m

Table 1 - Transmit Power Settings

The transmit power setting for the gateway is found in the gateway Configure Base Station
menu.

Figure 33 - Transmit Power Setting
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5.4 Setting the Serial Baud Rate

Changing the RS232 gateway baud ratemaymake it inoperable.

l TheRS232 gateway is set to communicate at a 115,200 baud rate when it is
manufactured. For most computer serial ports, 115,200 baud is the
maximum supported rate. On these computers, if the gateway is set to
921,600 baud it will no longer be able to communicate with the computer. To
restore, the gateway will need to be connected to a (non- standard)high
speed port, or the returned to the factory for reconfiguration.

l TheRS232 gateway does not support Synchronized Sampling unless it is set
to 921,600 baud and used with a high speed serial port.

1. Open Node Commander® and establish communication with the gateway (see
GatewaySerial Communication on page 29).

2. Right click on the gateway name header and select Configure and adjust the Baud
Rate as needed.

Figure 34 - Setting the Baud Rate
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5.5 Analog Gateway Configuration

In addition to normal digital communications, such as serial and Ethernet, analog gateways
have eight channels of configurable outputs that recreate selected sensor input channels of
connected nodes. The analog gateway channels are mapped to a node sensor channel
through the Node Commander®Configure Nodemenu.

Thismenu window is accessed by right clicking on the node heading in the Controller window
and selecting Configure > Configure Node. The Analog Pairing menu is used to assign node
channels to analog gateway outputs by entering the node address and channel number.
Channels can be assigned frommultiple nodes. Further configuration options, such as enabling
a no signal timeout and selecting signal processing modes, are available in thismenu. Refer to
the gateway user manual for more information.

Analog gateways have two programmable buttons located on the front of the device. The
function of these buttons can be assigned or disabled in the Buttons menu, and include power
and sampling options.

Figure 35 - Analog Gateway Configuration
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6. Node Communication

The node has three communication states; Active, Idle and Sleep (see NodeOperational Modes
on page 43). Node configuration is only possible when the node is in the idle state. If it is configured
for a normal boot mode, the node will enter idle state once the boot-up sequence is complete. The
node can also be configured to boot-up in sample or sleep mode. This can be accomplished in a
few different ways. For example, the node may be configured to boot-up and then start sampling
continuously. In that scenario the node will never go into the idle state so configuration of the node
is not possible until a stop command is executed to end the sampling. In other boot modes, the
node will boot up, sample, and then go into idle state (at which point configuration can occur). The
sample duration on these boot up sequences is determined by the sampling settings. Newly
manufactured nodes are configured for normal boot mode. SeeNode Boot Modes on page 59 for
more information about setting and overriding boot modes.

NOTE

Nodes and gateways have status indicator lights that flash in different patterns
to describe what mode they are currently in, or activity that is occurring. Refer to
the device user manual for details.

The boot mode also determines the state the node will go into after the user-configurable timeout
interval has occurred (see Node Power Management on page 52). For example, when the node is
in the normal boot mode, it will go into the sleep state after the timeout interval has passed. This is
useful for power conservation, however, to put it back in idle state for configuration, the node stop
or wake commandmust be executed.

NOTE

If the node has been inactive for longer than the user timeout period, or if the
node has entered sleep or sample modes for any reason, execute a stop node
command in order to perform configuration tasks.
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When a node is communicating with the gateway it will appear in the Controller window on a list
under the host gateway. The listing includes the node name and serial number. Additional node
information can be viewed by selecting the “+” symbol.

Node Commander® remembers nodes, and gateways, that have been communicated with
previously. Theywill appear on the list when the software is started, however, may not actually be
communicating with the gateway. Select the “+” symbol next to the node name to verify the
connection. An error will appear if it is not. To reconnect with a previously connected node see
Reestablishing Communication on page 48.

Figure 36 - Node Communication

There are several methods to establish communication with a new device.

1. Automatically with the Node Discovery feature (see Connect to Nodes on page 44).

2. Manually by entering the node address (seeManually Adding Nodes on page 46).

3. By scanning a range of node addresses (see Scanning for Nodes by Address on
page 47).

In normal boot mode, the node will power on, send a status message and then enter idle state
to wait for a command. Automatic node discovery only occurs in the status message phase of
the boot up. If the node is already in idle state, or in any other state, node discovery will not
work. Using other methods of establishing communication with the node, such as adding the
nodemanually, works only after boot up is complete and the node is in the idle state.
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6.1 Node Operational Modes

Sensor nodes have three operational modes: active , sleep , and idle. When the node is
sampling it is in activemode. To stop sampling, the node is put into idle mode. Idle mode is used
for configuring node settings (such as frequency and sampling rates) and is the only way to stop
sampling or go between active and sleepmodes. Sleepmode is an ultra low power mode. The
node will automatically go into sleep mode after a user-settable period of inactivity. The node
will not go into sleepmodewhile sampling.

Figure 37 - Node Operational Modes
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6.2 Connect to Nodes

Several methods can be used in Node Commander® to establish communication with the
nodes. This quick start section covers the two simplest methods; adding a node by address and
by using the node discovery feature.

6.2.1 Adding a Node by Address

Adding a node by address requires the node to be on the same communication frequency
as the gateway. The node address and frequency are indicated in the documentation
included with the node when it is purchased.

1. To add a node by address, right-click on the gateway name in the Controller window,
and select Add Node > Add Single Node (Figure 38 - Adding a Node by Address).

2. The node address and frequency are indicated in the documentation included with
the node. Enter the node address, and select OK. If the node is not found, amessage
will appear and provide the option to scan for the node on other frequencies.
Alternately, the Node Discovery feature can be used.

Figure 38 - Adding a Node by Address
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6.2.2 Using Node Discovery

The Node Discovery feature allows connection between the gateway and node to occur
even if they are on different frequencies. To connect to nodes using node discovery, begin
bymaking sure the node is powered off.

NOTE

Automatic node discoverymay not work in some boot-up modes. If the node is
not in normal boot upmode, the assigned one can be bypassed to enable node
discovery. For more information see Troubleshooting Guide on page 118.

1. Right-click on the gateway name and select Add Node > NodeDiscovery (Figure 39 -
Using Node Discovery).

2. Using the power switch, turn on the node. Within a few seconds, the node will
transmit a message with its operating frequency.

3. When the device status indicator on the node ends the rapid flash sequence and
begins pulsing at one-second intervals, the node has completed the normal boot-up
sequence and is running in idle mode. At this point the node should be listed in the
Controller window; scanning can be stopped by selecting the Stop button in the Node
Discovery window.

Figure 39 - Using Node Discovery
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6.2.3 Manually Adding Nodes

Nodes can bemanually added if the node address is known. The address is indicated on the
functional test or calibration document included with the node when it is purchased. The
gateway will search for the node on the frequency it is currently set to. If the node is on a
different frequency, the gateway frequency must be changed in order for the manual
addition of the node to be successful. See Transmit Frequency on page 37 for instructions
on how to set the gateway frequency.

1. Make the hardware connections and establish communicationswith the gateway.

2. Power on the node.

3. Right click on the gateway name in the Controller window and select Add Single
Node.

4. Enter the node address and select OK. If the node is not found an error message will
appear and provide the option to scan for the node on other frequencies.

5. If the node is found, verify communication by expanding the node information list with
the "+" symbol beside the node heading. If the information list appears,
communication has been established.

Figure 40 - Adding a Node by Address
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6.2.4 Scanning for Nodes by Address

Nodes can found by scanning an address range. The gateway will search for nodes on the
frequency it is currently set to. If the node is on a different frequency, the gateway frequency
must be changed in order for the scan to be successful.See Transmit Frequency on page
37 for instructions on how to set the gateway frequency.

1. Make the hardware connections and establish communicationswith the gateway.

2. Power on the node.

3. Right click on the gateway name in the Controller window and select Scan Network.

4. Enter the node address range. The wider the range, the longer the scan will take.

5. Select OK.

6. If the node is found, verify communication by expanding the node information list with
the "+" symbol beside the node heading. If the information list appears,
communication has been established.

Figure 41 - Scanning Addresses
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6.3 Verifying Node Communication

Use the Ping command to verify communication with a node at any time. Right click on the node
name in the Controller window and select Communicate > Ping from the node menu. The
Action Log window will report if the Ping was successful or not. A successful ping means the
node is communicating with the gateway.

Figure 42 - Test Node Communication

6.4 Reestablishing Communication

Node configuration cannot occur when the node is sampling or sleeping. The Stop Node
command is used to end whatever activity the node is currently performing, put the node into
idle mode, and allow configuration. It can be use to exit sampling modes, such as sampling on
boot up, and to interrupt other routines, such when the node is in sleep mode. To execute a
Stop Node command, right click on the node name in the Controller window, and select
Communicate > Stop Node from the node menu. After the node has been stopped, node
menus, such asConfigure, will become accessible.

Figure 43 - End Node Activity to Reestablish Communication
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6.5 Network Broadcast

The network broadcast feature is used to send the same command at the same time tomultiple
nodes connected to the same gateway. Nodes must be on the same transmission frequency
(channel) as the gateway to receive broadcast commands. Network broadcast functions
include communications, sampling, and configuration commands.

Network broadcast commands are found in the gateway menu. Right click on the gateway
name, and select Network Broadcast. Then select the desired category and command.

Sample

l Synchronized Sampling Start

l Low Duty Cycle Start

l ArmedDatalogging

l Trigger Datalogging Session

l Erase

Communicate

l Ping

l Stop Node

l WakeNode

l Sleep

l Cycle Power

Configure Figure 44 - Network Broadcast Commands

l Read/Write EEPROM



Node Commander® Software Suite UserManual Node Communication

50

6.6 Removing Nodes

To remove a node that is no longer used, right click on the node name in the Controller window
and select Remove Node from the nodemenu.

Figure 45 - Removing a Node
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7. Node Settings

7.1 Node Information

Node information, such as the model type, serial
number, radio type, operating frequency, node
address, and memory size, is found below the
node name in the Controller window or more
extensively in the node Info window.

Clicking in the "+" symbol next to the node name
will produce a list of some of the node
information (Figure 46 - Node Information). The
same thing can also be accomplished through
the Communicate menu by right clicking on the
node name and selecting Communicate > Load
Node Information.

Figure 46 - Node Information

If the node information will not load, the node is not communicating. Try executing the Stop
Node command to ensure the node is not in a sampling or sleepmode, and then load
node information.

More node information can be found in the node Info window. This window is accessed by right
clicking on the node name and selecting Configure > Configure Node and the Info tab. In the
node Info tab there is a field to give the node a unique name, which is useful when there are
multiple nodes (Figure 47 - Additional Node Information and Name). Node settings can be
saved and loaded aswell.See Saving Node Settings on page 62.

Figure 47 - Additional Node Information and Name
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7.2 Node Power Management

The node power management features can be used to conserve power when the node is not
actively sampling. Power management features include an ultra low power sleep mode, node
boot up options, radio check interval settings, and an inactivity timeout.

Node power management features are available in two menus. For direct control over the
current state of the node, right click on the node name and select, Communicate > Power
Management. This menu is used to set the node into sleep mode. The node will stay in sleep
mode until the Wake command is executed from the same menu. The Action Log window will
display the status of the command. There is also a command to cycle power to the node. This
software reboot feature is used in special cases, such aswhen using the Read/Write EEPROM
command to program the node or for troubleshooting if the node is unresponsive.

Figure 48 - Node Power Basic Commands

Additional power settings are found by right clicking on the node name and selecting Configure
> Configure Node. Select the Power tab.

NOTE

If the inactivity timeout is set to a very short duration, it may be difficult to
execute commands before the timeout occurs. In this case, use the Stop Node
command to re-establish communication and extend the timeout before it
occurs again.
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l Radio Check Intervals is how frequently the node turns on the radio to listen for
communications while it is sleeping. Longer wait intervals will result in less power use but
alsomeans theremay be a delay between the time when the node is sent aWake command
and when it actually wakes up.

l User Inactivity Timeout is the amount of time that has to passwith no commands before
the activity related to node boot mode occurs. For Normal Boot mode, this is the time of
inactivity that has to pass before the node goes to sleep. In some boot modes, such as
Synchronized Sampling, it will begin sampling after that period of time .

l Boot Mode determines what the node will do when it is turned on. Most of the boot options
are related to what type of sampling is desired and not directly to do with power
consumption, however some sampling modes use significantly less power than others. For
example, Low Duty Cycle uses a lot less than streaming because the node is only on and
transmitting periodically.SeeNode Boot Modes on page 59.

Figure 49 - Advanced Power Settings
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7.3 Transmit Frequency

NOTE

l The gateway can automatically manage nodes operating on different frequencies
by using the Node Discovery feature in Node Commander®. In this routine, the
gateway listens for node broadcasts on the frequency channel to which it is set. If
the node is in normal boot-up mode, it will provide the broadcast when it is initially
powered-on, and it will broadcast on all channels. As long as the node is powered-
on after activating the Node Discovery feature, the gateway will link to it and
remember the channel setting for future node queries.

l Manually matching the node and gateway frequency channels is required in some
applications. For example, when sending broadcast messages from the gateway to
multiple nodes (including the synchronized sampling beacon) all nodes must be on
the same channel as the gateway in order to receive the broadcast. Assigning
channels is also a good idea when multiple gateways are attached to one host
computer or when other wireless equipment is nearby and frequency or
transmission interferencemay occur.

The frequency setting for the node is found in the node Configuremenu.

Figure 50 - Node Frequency
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7.4 Transmit Power

The transmit power level may require adjustment if power consumption is a concern or in
regionswhere there are transmit power restrictions. Lowering the power output reduces power
consumption, but it also reduces the wireless communication range between the gateways and
nodes.

NOTE

Actual range is highly dependent of how the nodes and gateways are installed and the
conditions in the surrounding environment (see Range Test on page 56).

Setting Power Output
Maximum
Range

Extended 16 dBm (39mW) 2 km
Standard 10dBm (10mW) 1 km
Low 0dBm (1mW) 70m

Table 2 - Transmit Power Settings

The transmit power setting for the node is found in the Configure Nodemenu.

Figure 51 - Transmit Power Setting
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7.4.1 Range Test

After establishing communication between node and gateway, use the range test feature in
Node Commander® to monitor the signal strength and to optimally position the nodes,
gateway, and antennas for installation. Maximum achievable range is determined by the
gateway and node power settings (found in the device Configure menu) and is highly
dependent on the physical environment surrounding the devices.

1. Right-click on the node header, and select Communicate > Range Test.

Figure 52 - Range Test Menu

2. The total RSSI range for the node and gateway is -90 to 0dBm. The higher
the value(closer to zero), the better, but reliable communication can be
achieved between - 75 dBm and 0 dBm. The devices is still able to
communicate between -90 dBm and -75 dBm, but it could be intermittent or
result in data loss. Position the node and gateway antennas where the best
RSSI value is observed.

Figure 53 - Range Test Statistics
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7.5 Channel Configuration

The sensor settings are stored in the node memory, and each sensor is assigned a
corresponding channel number. The configuration menus will only show the channels and
configuration options that are available for the type of node being used.

1. To enter the configurationmenu, right-click on the node name, and select Configure >
Configure Node. The Channels tab displays channel options available for the node.

a. Channel Enabled: indicates the sensor channel number. The check box
is used to enable the channel and select it for sampling. The icon next to
the check box describes the channel type inherent to the node being used.
In the following example (Figure 54 - Node Channels Menu): a1) analog
differential channel icon, a2) analog single ended channel icon, and a3)
temperature channel icon.

b. Current channel configuration: The Data Output, Units, Input Range,
and Label fields describe how the channel is currently configured.

c. Configure: TheConfigure button changes the channel parameters, such
as measurement units, gain and offset settings, and calibration
values. The channel must be enabled first by selecting the adjacent check
box.

Figure 54 - Node Channels Menu
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2. To enter the channel configuration menu, select the Configure button as shown in
Figure 54 - Node ChannelsMenu.

a. Channel Label: names the channel

b. Channel diagram: shows channel electronics and data flow

c. Conversion Coefficients: defines the type and units of the
measurement beingmade

d. PGA Settings: These settings determine what gain is applied to the
sensor measurement and set the position of the no- load baseline
measurement for the sensor signal. It is only available for differential input
channels with gain amplifiers.

e. Calibration values: includes the slope, offset, scale, and formula used to
convert the sensor reading to engineering units. The slope and offset can
be determined from the sensor manufacturer calibration data or through a
calibration process.

Figure 55 - Channel Setup
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7.6 Node Boot Modes

Nodes can be configured to boot up in several different ways, depending on the application
requirements (Table 3 - Node Boot Modes ). For sample on boot up modes, the node will
sample according to the sampling settings configured for the node. This is especially useful
when data acquisition through SensorCloud™ is desired. By setting the node to sample on
boot up Node Commander® will not be required to initiate sampling as the node will begin
sampling automatically. Depending on the settings, it may either boot up and sample
continuously or boot up, sample for a fixed interval, and then go into idle state.

Setting the node up for different modes will effect the way communication can be established
with the node.

l If the node is sampling or sleeping on boot up, node configuration cannot occur until the
sampling is completed or the Stop Node command is executed.

l Node boot modes can be bypassed by toggling the nodeON/OFF switch rapidly three
times and leaving it in the ON position. This will result in a normal boot up.

Boot Mode Description
Node Device

Indicator Sequence

Normal
Node turns on, sends out a
statusmessage, and then waits,
in idle, for a command.

Several rapid flashes, then
pulses in one second intervals.

Low Duty
Sampling

Node turns on and takes a
sample at set parameters.

If set for a fixed sample interval,
on completion, the node sends
out a statusmessage and then
waits, in idle, for a command.

If set for continuous sampling,
the node turns on and samples
until a stop command is sent.

If set to synchronized sampling
the node turns on, waits until a
beacon is received on the same
frequency, and then samples

Pulses at the set sample inter-
val when sampling. Normal
boot indicator sequence on
completion

Synchronized
Sampling

On solid while sampling.
Normal boot indicator
sequence on completion

Stream
On dimly while sampling,
normal boot indicator sequence
on completion

Datalog

One flash when sampling, then
on dimly when datalogging.
Normal boot indicator
sequence on completion

Sleep
Node turns on, and then goes
into sleepmode.

Off, with occasional flash at set
radio check interval.

Table 3 - Node Boot Modes
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1. To change the node boot mode, right click on the node name and select Configure >
Configure Node from the nodemenu.

2. Select the Power tab.

3. Select the desired boot mode from the drop downmenu.

4. Select Apply or OK. The next time the node is restarted it will boot up in the new
mode. It must be a full power reset; the Cycle Power command in Node Com-
mander®will not work for this.

Figure 56 - Boot Mode Setting
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7.7 Applying Node Configuration

Node values set in any of the tabs in the node Configure menu are saved to the node using
either the OK or Apply buttons. The OK button saves and exits the menu, while the Apply
button writes the values, but does not exit themenu, allowing additional settings to be changed.
Changesmust be applied before selecting another tab, or theywill not be saved.

Figure 57 - Applying Node Settings
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7.8 Saving Node Settings

The Save Node State feature creates a file to backup all of the node settings, including factory
and user entered calibration values, channel configurations, sampling settings, and
communication settings. The settings file contains the unique node address and any applicable
factory calibration values and is therefore unique to each node . It is important that a saved file
only be loaded on the node it was created on, or the node address and factory calibration
values will be overwritten. If external sensors have been replaced or disconnected since the
settings file was created, recalibration of the sensorsmay be necessary.

The Save Node State and Load Node State features are found in the node Info window. The
Info window is accessed by right clicking on the node name in the Controller window and
selecting Configure > Configure Node. Name the node settings file with a name that indicates
which node it is, for example using the serial number.

Use the Load Node State button to reload previously saved node settings files.

Figure 58 - Node Settings File
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7.9 Node EEPROM Settings

Advanced settings can be configured by using coded commands to write directly to the node
EEPROM. The EEPROM addresses and settings are available from LORD MicroStrain®

Technical Support Engineers and are only required in special circumstances.

The EEPROM read/write menu is available though the node menu. Right click on the node
name and select Configure, Read/Write EEPROM. Enter the EEPROM command address
and value and then click Read or Write, as applicable.

Figure 59 - Read/Write Node EEPROM
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8. Sensor Settings

LORD MicroStrain® sensor nodes are designed to accept many sensor types and some have
integrated sensors. Some nodes havemultiple input channels and channel types. Available sensor
settings vary depending on the type of node being used and what channel the sensor is connected
to. The node configuration interface changes accordingly and can include settings for
measurement units , gain settings, and conversion values. For more information see Sensor
Calibration on page 74. See Channel Configuration on page 57 for menu interface information.
There are preset measurement units, as well as a user-defined field. Because the wireless sensor
system is digital, the analog voltage readings from the sensors are converted into a digital
equivalent value based on the volt-to-bit scale of the internal analog-to-digital voltage converter
(A/D converter). Sensor readings can be displayed and recorded in volts and A/D value (bits)
directly or further converted to engineering units by applying conversion values and a conversion
formula. For more information see Sensor Conversion Values on page 67, and for instruction of
adjusting units seeMeasurement Units on page 66.

Some sensors require calibration to determine more accurate conversion values. Calibration
incorporates coefficients that normalize the sensor output to a known reference device and
guarantee accuracy of conversions.

Internal sensors are assigned to a specific channel at the factory and the channel number cannot
be changed. Some internal sensors are also calibrated at the factory. The calibration values can
be changed. Table 4 - Example Internal Sensor Types, describes some internal sensor types,
units and calibration options.

example
internal sensors

units calibration options

accelerometer

acceleration g-force

A/D value

custom

factory calibration

user entry from lab or field
calibration

temperature

temperature

A/D value

custom

calibration not required

factory calibration

user entry from lab or field
calibration

Table 4 - Example Internal Sensor Types
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External sensors can be attached to any channel that is suitable for sensor type. Table 5 - Example
External Sensor Types, describes example sensors, units, and calibration options.

channel type
example

external sensors
units

calibration
options

analog
differential
input

strain gauges in full, half,
quarter/custom Wheatstone
Bridge configurations

strain

volts

A/D value

custom

calibration
wizard

user entry from
manufacturer
data, lab or field
calibration

other Wheatstone Bridge
sensors such as:

some pressure sensors

some force sensors

somemass sensors

some displacement sensors

some accelerometers

some temperature sensors

4-20mA sensors

g-force

A/D value

volts

custom

English and metric
measurements for;
mass, pressure,
force, distance, and
temperature.

user entry from
manufacturer
data, lab or field
calibration

analog
single ended
input

sensors with voltage outputs
referenced to the system
ground.

volts

A/D value

custom

user entry from
manufacturer
data, lab or field
calibration

thermocouple thermocouples

temperature

A/D value

custom

user entry from
manufacturer
data, lab or field
calibration

accelerometer accelerometers

acceleration g-force

A/D value

custom

user entry from
manufacturer
data, lab or field
calibration

Table 5 - Example External Sensor Types
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8.1 Measurement Units

Sensor measurement units are set in the channel Configurationmenu.

1. To enter the Configurationmenu, right-click on the Node heading, and select Configure >
Configure Node. The Channels tab displays channel options available for the current node.

Figure 60 - Channel Configuration Menu

2. Select the type of measurement from the Classmenu, and then select Units.

Figure 61 - Select Sensor Units
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8.2 Sensor Conversion Values

The conversion values include the slope, offset, gain, scale, and formula for converting the
sensor A/D value (bits) to engineering units. The bits are the digital representation of the
sensor voltage output. The type of sensor, channel, and desired engineering units
determine what conversion values are available. The conversion values are entered
through Node Commander® and saved in the nodememory for the applicable channel.

NOTE

In order to report accurate readings, many sensors require calibration. 
Calibration coefficients normalize the sensor output to a known reference
device and are often expressed in themeasurement unit conversion values; the
only difference being the use of a traceable reference. Calibration can be used
to account for the variations between individual sensors, wiring, system
electronics, sensor mounting and environmental conditions.See Sensor
Calibration on page 74.

The conversion values can be entered in two menus. The channel Configuration menu has
more options than the Calibration Coefficientsmenu, but both are acceptable ways to enter
the values and formulas.

Figure 62 - Abbreviated Conversion Values Menu
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Figure 63 - Advanced Conversion Values Menu

Conversion Formula: The conversion formula assumes a linear relationship between the
original units (such as volts or A/D bits) and new engineering units (such as ), and it is
expressed mathematically as y=mx+b, where y is the engineering units at a given point
(measurement),m is the slope of the line that represents the linear ratio, x is the original unit
value at a given point, and b is a unit conversion offset (in the case of unit conversions) or the
fixed zero load offset of the sensor (in the case of measurement calibration coefficients).
Negative valuesmay be entered for any coefficient.

Slope: is the linear scaling slope coefficient. The slope is the ratio of original units to new
engineering units (EU), and it is used to convert the sensor measurements. The slope
conversion value will vary depending on the engineering units desired. For example if the
original unit is A/D values (bits), and the desired engineering units are acceleration in g-
force, the slope conversion would describe how many bits equal one unit of g-force (bits/g).
Mathematically, the slope ism in the formula y = mx +b.

Offset: is the linear scaling offset coefficient, and it is typically the starting output value of the
sensor with no load applied (in the original units). Mathematically, the offset is b in y = mx +b.

Effective Range: the effective range is the calculated sensor measurement range in
engineering units (EU). The effective range is dependent on the slope, offset and resolution
of the node. The effective range is the number of bits per EU unit (slope) multiplied by the
total number of bits, minus the offset (if applicable).
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Input Range (Gain): This sets the amplification of the signal within the node and is only
available for channels with differential inputs and gain amplifiers.

Offset Scale (with Auto Balance):This feature is only available for channels with
differential inputs, and assigns the position and value of the no load measurement of the
sensor. The offset scale level adjusts the operating window of the sensor measurements in
reference to the entire range. For example, in mid scale the sensor no load measurement
will be placed in the middle of the range, providing 50% of the range for positive readings
and 50% of the range for negative readings. Once the scale level is selected, the Auto
Balance procedure is used to assign the actual sensor no- load measurement to the
designated scale.

l Low is for positive-going signals (zero at 25% of total range).

l High is for negative-going signals (zero at 75% of total range).

l Midscale is for positive and negative-going signals (zero at 50% of range).

Figure 64 - Offset Scale Setting
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8.2.1 Calculating a Linear Slope

A data analysis tool such as Microsoft Excel can be used determine the slope of a linear
relationship between sensor output A/D value (bits) and engineering units. This is not a
calibration unless a calibrated reference device is used to measure the applied loads. For
information and examples for determining calibrations coefficients see Sensor Calibration
on page 74 .

Here is an example, using Excel:

1. Open a blank spreadsheet.

2. Enter the A/D value (bits) measurements and applied load in the desired engineering
units in two columns. Enter A/D value in the left column (x-axis value) and the applied
load in the right (y-axis value).

3. From the Insert menu, select Chart > Scatter. Select the preferred format.

Figure 65 - Generate a Scatter Chart
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4. Right-click on the graphed line, and select Add Trendline .

5. Designate the line as Linear, and check the option to Display the Equation on the
chart (Figure 66 - Plot Trendline).

Figure 66 - Plot Trendline

6. The formula of the line is y=mx+b, where y is the engineering units at a given point
(measurement),m is the slope of the line that represents the linear ratio, x is the A/D
value at a given point, and b is the fixed zero load offset of the sensor. Enter the slope
and offset as the conversion values for the sensor channel under the applicable
engineering units. In this example, enter 0.1338 for the slope and -282.36 for the
offset for the units conversion values on themeasured channel.

Figure 67 - Slope and Offset Values
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8.2.2 Differential Input Gain and Offset

The combination of the gain, offset, and sensor signal cannot exceed the 0 to 3 V dc input of
the analog to digital converter within the node. See Example Gain and Offset Calculations
on page 73.

Resolution: Applying gain to the sensor signal can be used to maximize the
measurement resolution. The more of the range that is used, the more digital counts are
available to measure the signal, which typically means higher resolutionmeasurements.
Limitations to the gain adjustment are the sensor'smeasurement capabilities and the 0 to
3V input range of the node. The signal produced after gain is applied to the sensor at full
scalemust not exceed the input range of the node.

Offset Scale:The scale setting positions the no-load measurement of the connected
sensor within the 0 to 3V range of the node input. The range of A/D counts that
corresponds with the 0 to 3V node input depends on the resolution of the node. For
example, a 12-bit node will have a full scale bit range of 4096 and a 16-bit node will have
a full scale bit range of 65535. A mid-range setting positions the baseline offset in the
middle of the range (1.5 V or full scale bits*1/2) and is used for sensors with negative and
positive going signals. The low-range setting positions the baseline offset in the bottom
quarter range (750mV or full scale bits*1/4) and is used for sensors with mostly positive
going signals. The high-range setting positions the baseline offset in the top quarter of
the range (2.25 V or full scale bits *3/4) and is used for mostly negative going signals.

Figure 68 - Differential Input Resolution and Offset (16-bit Node)
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8.2.2.1 Example Gain and Offset Calculations

EXAMPLE 1:

Sensor signal range: 0 to 50mV
Gain setting: 21
Baseline offset range setting:Mid-range

Calculations:

50mV * 21 = 1.05 V (maximum voltage of sensor signal with gain)
1.05 V + 1.5 V = 2.55 V ( maximum input voltage to node with gain and offset)

Calculated node input over sensor range: 1.5 to 2.55 V

This is a good setting because the node input voltage is within the 0 to 3 V range.

EXAMPLE 2:

Sensor signal range: 0 to 50mV
Gain setting: 30
Baseline offset range setting: Low-range

Calculations:

50mV * 30 = 1.5 V (maximum voltage of sensor signal with gain)
1.5 V + 750mV = 2.25 V ( maximum input voltage to node with gain and offset)

Calculated node input over sensor range: 750mV to 2.25 V

Thismay be a better setting than in Example 1 because the gain is higher, which could increase the
resolution of themeasurement. The node input voltage is still within the 0 to 3 V range.

EXAMPLE 3:

Sensor signal range: 0 to 50mV
Gain setting: 75
Baseline offset range setting: Low-range

Calculations:

50mV * 75 = 3.75 V (maximum voltage of sensor signal with gain)
3.75 V + 750mV = 4.5 V ( maximum input voltage to node with gain and offset)

Calculated node input over sensor range: 750mV to 4.5 V

This setting will not work because the node input voltage is outside of the 0 to 3 V range.
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8.3 Sensor Calibration

Many sensors require calibration coefficients to accurately report measurements. Methods for
determining the calibration coefficients depend on the type of sensor measurement and
application. The Node Commander ® software facilitates multiple calibration methods. 
Calibration calculators for some applications are also available by contacting LORD
MicroStrain® Technical Support.See Technical Support on page 127.

l Sensor manufacturer’s specifications or calibration: The slope and offset
values, or the data to derive them, are provided with the sensor by the manufacturer
to prove its accuracy and describe expected voltage output.   Some sensors are
calibrated individually, while others are manufactured to a standard sensitivity value
(plus or minus some tolerance), which is provided in the device specifications.

l Sensor lab calibration: If the manufacturer's calibration is not available or
outdated, calibration of the sensor can be performed with calibrated equipment in a
controlled environment. The calibration equipment and process will typically be
traceable to an industry standard, such as NIST or ASTM in the United States. Fixed
loads are applied to the sensor while the sensor output is recorded. The load is
applied or measured by a calibrated reference device. The known load value from the
calibrated device is then plotted against the measured output of the sensor to
determine the calibration slope and offset. In Node Commander ® this can be
accomplished by taking sensor readingswhile applying the known loads.

Sensor wiring, tolerances in system electronics, and differences in mounting techniques are
examples of systemic variables that can influence the sensor readings.  Sensors that are
making small measurements or are otherwise sensitive to these slight differences may benefit
from a system calibration. The following techniques are system calibrations:

l System shunt calibration (internal and external): This option is only available for
Wheatstone bridge-type sensors (such as strain gauges) and utilizes a calibration
wizard in Node Commander®. In the shunt calibration process, an internal or external
precision resistor is used to load part of the sensor bridge while the sensor remains
unloaded.  The bridge output is measured and used as a loaded calibration point for
the sensor.  In addition to the no-load value it can be used to derive the calibration
slope and offset. The internal shunt resistor is suitable for most applications, however
an external shunt may be beneficial in high gain scenarios.
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l System field calibration: The field calibration is a similar methodology to the
sensor lab calibration. Known loads are applied to the sensor while the sensor output
is recorded.  The load is applied or measured by a reference device. In this scenario,
the sensor may be installed in final field configuration, and the load may be applied
with the actual stimulus that the sensor will bemonitoring. The known load value from
the reference device is then plotted against the measured output of the sensor to
determine the calibration slope and offset. In Node Commander ® this can be
accomplished by taking sensors readingswhile applying the known loads.
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8.3.1 EXAMPLE: Lab or Field Calibration

The lab and field calibrations use similar methodology.See Sensor Calibration on page 74.
The primary difference is the traceability and calibration environment. Lab calibrations are
performed in controlled environments with traceable equipment and procedures. Field
calibrations aremore improvised, although calibrated equipment can still be used to improve
accuracy.

NODE:V-Link® -LXRS® ,16 bit (65535 A/D values)

CHANNEL TYPE: differential analog input, 0 to 3 V dc input range

SENSOR TYPE: load cell

SENSOR PARAMETERS: application voltage range: +/-20mV

This is the expected output voltage of the sensor based on the range of force being
measured in the application and the sensitivity of the sensor (V/engineering units)

DESIRED OUTPUT: engineering units (EU), force (lbs)

PROCEDURE:

1. Open Node Commander®, and establish communication with the gateway and node
(see SystemOperational Overview on page 13).

2. Right-click on the node heading and select Configure > Configure Node. Select the
check-box for Channel 1, which is where the strain gauge is connected, and then
select the Configure button.

Figure 69 - Node Configuration Menu
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3. Use the following settings (Figure 70 - Channel Settings):

a. Conversion Coefficients, Class: A/D value

b. Conversion Coefficients, Units: bits

c. PGA Settings, Input Range: +/-20mV (expected sensor range)

d. PGA Setting:Midscale (for positive and negative going signals)

4. Select the Auto Balance button to tare the no-load value of the strain gauge. ClickOK
to apply the node settings and exit configuration.

Figure 70 - Channel Settings

5. Right-click on the node heading, and then Sample > Stream > Start.

Figure 71 - Start Node Streaming



Node Commander® Software Suite UserManual Sensor Settings

78

6. The streaming graph shows the bit output of the channel. 

7. Using a calibrated tool (or some other way of applying and measuring a known load)
and apply loads to the sensor at a number of intervals over the expected range of use. 
At each of the calibration intervals, record the applied force  and the corresponding
sweep value on the y–axis of the graph (the A/D value output of the sensor).

a. Zoom in and out on the graph by un-checking the Auto Y-Axis Zoom box,
and then right clicking on the graph and selecting Zoom In.  Draw a box
around the desired area to zoom in on.

b. Adjust the Y-AxisWidth from the field next to the Y-Axis Zoom.

c. End sampling by clicking the red X box on the StreamingGraph tab.

Figure 72 - Node Sampling
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8. After making all measurements, calculate a slope from the data using the formula
y=mx+b in a data analysis program, such as Microsoft Excel. See Calculating a
Linear Slope on page 70.

9. Return to the Node Configuration screen for the sensor channel, and select the
Conversion Coefficients Class and Units, and enter the Slope and Offset values
derived in the data analysis program.

Figure 73 - Enter Calibration Values

10. Save the values, and exit configuration. This is the end of a lab calibration.

11. For field calibrations, bbegin node data streaming again with no load on the sensor.

12. Observe the value in the stream graph. If the stream is not at zero, return to the
channel configurationmenu, and adjust the offset by increasing or decreasing the
value.

13. Once the offset has been zeroed, verify the calibration by applying known loads on
the sensor throughout the load range, observing and verifying the measurement in
engineering units.
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8.3.2 EXAMPLE: Internal Shunt Calibration

NODE: V-Link® -LXRS® ,16 bit (65535 A/D values)

CHANNEL TYPE: differential analog input, 0 to 3 V dc input range

SENSOR TYPE: strain gauge,Wheatstone Bridge, full bridge configuration

SENSOR PARAMETERS: application voltage range: +/-2 mV

This is the expected output voltage of the strain gauge based on the range of strain being
measured in the application and the sensitivity of the gauge (volts/strain).

DESIRED OUTPUT: engineering units, microstrain

PROCEDURE:

1. Open Node Commander®, and establish communication with the gateway and node.
(See SystemOperational Overview on page 13.)

2. Right-click on the node name, and select Configure > Configure Node.

3. Select the check-box for Channel 1, which is where the strain gauge is connected,
and then select the Configure button.

Figure 74 - Node Configuration Menu



Node Commander® Software Suite UserManual Sensor Settings

81

4. Use the following settings;

a. Conversion Coefficients, Class: Strain

b. Conversion Coefficients, Units: uStrain

c. PGA Settings, Input Range: +/-2.5mV (expected sensor range)

d. PGA Setting:Midscale (for positive and negative going signals)

5. Select the Auto Balance button to tare the no-load value of the strain gauge. Observe
the value returned for the Auto Balance value.

Figure 75 - Channel Settings
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6. Select the StrainWizard.

7. Select the appropriate Bridge Type and click Next.

8. Select Use the Strain MeasurementWizard and click Next.

9. Set the following parameters:

a. Number of Active Gauges: number of a strain elements connected (for
example: 4 for a full-bridge, and 2 for a half-bridge)

b. Gauge Factor: ratio of mechanical strain to electrical output (a gauge
specification).

c. Gauge Resistance: Enter the strain gauge ohm value (a gauge
specification).

d. Shunt Resistance: 499000 ohms

Figure 76 - Strain Wizard Settings

NOTE

Touching sensors and test boards or charging the node battery while acquiring
datamay induce noise on sensitive sensor signals and is not recommended.
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10. Select Calibrate.

11. Verify the calibration looks as shown in Figure 77 - Strain Gauge Calibration.  The
green line represents the output of the strain gauge. With no load applied it should sit
near the Auto Balance baseline value, represented by the red dashed line.  During
calibration, a shunt resistance (selected on the Parameters page) is applied across
the strain bridge, shown by the square pulse on the output.  The Offset value, shown
with the dashed blue line, is the average output value of the pulse and should sit
across the top of the pulse.  If the gauge has not had to time to equilibrate before
sampling, or if varying environmental factors exist, spikes in the gauge output may
occur and affect the Baseline and Offset values.  If this occurs, the Offset and
Baseline values can be adjusted to clip the spikes in the output values.  Adjust them
as needed, and select Accept when completed. 

Figure 77 - Strain Gauge Calibration



Node Commander® Software Suite UserManual Sensor Settings

84

12. Select Finish to end the Strain Wizard.  Note the slope and offset values have been
calculated automatically. 

Figure 78 - Completed Strain Wizard

13. Select OK to exit the Channel Configuration window.

14. In the Node Configuration window, select Apply to write the configuration and
calibration values to the node.

15. Select OK to exit.

Figure 79 - Apply Node Settings
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8.3.3 EXAMPLE: Manufacturer Calibration

NODE: V-Link® -LXRS® ,16 bit (65535 A/D values)

CHANNEL TYPE: differential analog input, 0 to 3 V dc input range

SENSOR TYPE: pressure transducer, voltage output, positive going

SENSOR PARAMETERS:

From themanufacturer calibration sheet included with the sensor;

sensor range: 0-250 psi
sensor zero load output: 0.0032 V dc
sensor full scale output (FSO) with 10V excitation: 86.07mV

From the application parameters;

sensor excitation in application: 3V supply from the node

DESIRED OUTPUT: engineering units (EU), psi

CALCULATIONS:

Because the sensor will be powered from the node with 3 V, and the sensor manufacturer
calibrated it a 10V, themanufacturer full scale output (FSO) value needs to be scaled to 3V.

(3 V/10 V) * 86.07mV = 25.82mV

Select a gain and offset scale value appropriate for the sensor. Because the signal is
positive going in this example application, the low offset scale will provide the largest range.
With the low offset selected, the effective input range of the node is 750 mV to 3 V (2.25 V)
(see Differential Input Gain and Offset on page 72). Calculate the highest gain possible by
dividing the actual input range by the sensor FSO.

2.25 V/25.82mV = 87

The closest gain setting below optimal gain for a V-Link® -LXRS® is 75 (+/-20 mV). Using a
higher gain value would exceed the input voltage capacity of the node when the sensor is at
higher pressures. This selection makes sense because the approximate input range
designation for a gain of 75 is +/-20 mV (a 40 mV delta minus 10 mV for the low offset),
which is close to the FSO range of the sensor.



Node Commander® Software Suite UserManual Sensor Settings

86

Multiply the sensor FSOby the gain setting to get the sensor voltage after amplification.

75 * 25.8 2mV = 1.9365 V

Scale the (gained) sensor input voltage/EU ratio to the node input voltage/EU ratio to
determine the equivalent node FSOvalue (x).

1.9365 V/250 psi=3 V/x
(250 psi * 3 V)/1.9365 V = x = 387. 3 psi

The node converts voltage inputs to A/D values. For a 16-bit node, there are 65536 A/D
values over the 3 V input range. Divide the node EU FSO by the A/D value to get the ratio,
or slope, of EU to A/D value.

387.3 psi/65536 bits = 0.00591 = slope

Once the slope is entered, the sensor offset value can be measured in a data sampling
session, such as streaming. Sample the sensor channel with no load applied, and read the
EU value. Enter this as a negative value for the offset in order to have it subtracted from
readings.
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9. Sampling Modes

Node Commander® offers up to four sampling modes: streaming, low duty cycle (LDC),
synchronized sampling, and datalogging. Available sampling modes are node specific. Refer to
the node specifications for what modes it has.

Synchronized Sampling: Synchronized sampling uses the LORD MicroStrain® LXRS®

communication protocol for micro-second time synchronization, lossless data throughput, and
predictable network scaling. Wireless nodes synchronize to a common time source to
guarantee node sampling within ±32 microseconds of each other. The common time source
also allows slotted transmission to avoid over- the-air collisions. Through the use of data
buffering, acknowledgments, and retransmissions the nodes are able to achieve lossless data
throughput under most conditions.

Synchronized sampling includes many options to facilitate easy data collection. These options
include continuous, periodic burst, or event triggered sampling schemes, as well as adjustable
sample rates, durations, and datalogging. To learn more about synchronized sampling and the
LXRS data protocol see Synchronized Sampling on page 89.

Low Duty Cycle: LDC mode is used in applications which require a low sample rate or low
latency. Features include configurable sample rate and duration, event based sampling,
datalogging, and data arrival time stamping (see Low Duty Cycle on page 94).

Datalogging: Datalogging used for saving data to internal node memory for future retrieval.
Features include adjustable sample rates, duration, multiple node triggering, and time stamping
(see Datalogging on page 96).

Streaming: Streaming is a general purpose sampling mode with very little latency between
sampling and the data display. Sampling rates are automatic, although duration is configurable.
Streaming mode does not support time stamping and is considered a legacy feature (see
Streaming on page 98).
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Within the samplingmodes, data is sampled either continuously, in period bursts, or in reaction to a
reading threshold (event-based). Availability of these options vary between sampling modes and
node models. The node specifications describe the available options, and the range of sampling
rates for each across samplingmodes. Samplingmode options are included in the following
descriptions.

Continuous sampling- With continuous sampling, samples will be taken at the set sample
rate for a set amount of time or until stopped. Used in LDC, streaming, datalogging, and
synchronized samplingmodes.

Periodic burst sampling - In burst sampling the node samples at the set sample rate in a
fixed window of time (burst), and then repeats that window at set sampling intervals. The burst
duration and time between bursts is configurable. Burst sampling continues until stopped. Only
available with synchronized sampling.

Event-based sampling - samples continuously while evaluating the data for a user-
configured sensor measurement value (threshold). When detected the data will be saved with
pre and post- event data, as defined in the event- based sampling settings. Available in
synchronized sampling and LDC modes.

Sampling settings are accessed through the Configure Node menu. There is a tab for each
samplingmode.

Figure 80 - Sample Settings Menu
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9.1 Synchronized Sampling

Synchronized sampling should be used when sample synchronization between nodes, network
scalability, or data loss prevention are critical to the application. The following describes these
main features of synchronized sampling.

Synchronization: Node to node synchronization is achieved through the use of a beacon.
During synchronized sampling, the gateway broadcasts a beacon packet containing a
Coordinated Universal Time (UTC) timestamp once per second. Nodes within the network
periodically synchronize to this beacon in order to maintain node-to-node timing within ±32 us.
Between synchronizations timing is maintained by a node-based, temperature compensated
real-time-clock, with drift rate of ±3 ppm. Sampled data is timestamped on the node in order to
retain the absolute timing of its measurement. For information about other available gateway
timing sources see Time Sources and Stamping on page 99.

Scalability: Nodes with similar or differing configurations may be included together in an
LXRS® network. Within synchronized sampling networks, time division multiple access
(TDMA) is utilized to avoid data packet collisions during radio transmission. Nodes are
allocated time slots based on the amount of data required to be transmitted, which is calculated
from settings such as sample rate, number of sensor channels, and data type. Time slot
allocation information is written to the nodes prior to sampling and determines how many nodes
can be on the network. To check the capacity of a network based on these settings, use the
online network bandwidth calculator:

http://www.microstrain.com/configure-your-system

Lossless: Nodes achieve lossless wireless communication during synchronized sampling
through the use of data buffering, acknowledgments, and retransmissions. Measured data and
time stamps are cached in a circular buffer on the node. The cache memory is a stand-alone
256 KB RAM (may be larger for some node models) that is separate from the flash storage
used for long term data logging. It can hold up to 100 K samples in standard bit format, or 50 K
samples in floating point format (see Figure 82 - Synchronized Sampling Settings, Packet
Formats setting (item f)). The data is transmitted in a first in/first out sequence within its allotted
time slots. Data packets are acknowledged by the beaconing gateway. If acknowledgment is
not received, the data packet is retransmitted in the next time slot. Nodes are allocated enough
radio bandwidth to allow recovery from environments with up to 20% or more packet loss.
Follow best practices to optimize radio transmissions links (see Range Test on page 56, and
node and gateway user manuals for more detailed information).

http://www.microstrain.com/configure-your-system
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Auto-sleep: An optional auto-sleep feature allows nodes to save power when the beacon is
removed.When enabled, nodeswill auto-sleep after the beacon is lost for a configured amount
of time. In auto-sleep the node saves power, and will rejoin the network within 2minutes of the
beacon returning. Refer to Figure 82 - Synchronized Sampling Settings, Beacon Lost Timeout
setting (item g).

Latency: In order to achieve lossless data throughput during synchronized sampling, non-
deterministic latency is introduced between sampling and data collection and display. During
normal operation when data packets are not being cached at a rate that exceed the capacity of
the data buffer, latency in synchronized sampling will be less than 1 second (up to 16 seconds
in high capacitymode - see Synchronized Sampling Data Acquisition on page 101). However,
if there are many transmission acknowledgment errors (as when there are RF range integrity
problems, including beacon loss, and a lot of data packets are being saved and retransmitted)
latency will increase. If the application requires very low latency, Low Duty Cycle (LDC)
sampling should be considered.

Figure 81 - Synchronized Sampling Sequence
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To adjust synchronized sampling settings, open the node configuration menu by right clicking
on the node name and then selecting Configure > Configure Node. Select the Synchronized
Sampling tab. Key menu options include the burst and event based sampling features (Figure
82 - Synchronized Sampling Settings).

Figure 82 - Synchronized Sampling Settings

a. Sampling settings: Sampling can be set to repeat for a fixed interval of time after
the sampling has started, or continuously until a stop command is sent. Only
appropriate settings combinations will be available in the sampling settings
selections (per the node specifications and bandwidth limitations).

b. Percentage of Total Bandwidth: as the sampling settings are adjusted the used
network bandwidth is calculated and displayed.

c. Event Driven Sampling: the data will be continuously sampled but only recorded
or transmitted when it meets the event criteria.See Event Driven Sampling on page
97.

d. Burst sampling: In periodic burst sampling, the duration of the burst and time
between bursts is configurable. The sampling repeat interval is limited to one day.
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When the Show AdvancedOptions check-box is selected several new menu options appear:

e. Action: configures the node to store sampled data in the nodememory (log), to log
the sampled data and transmit it to the gateway, or to only transmit it.

f. Packet Format: There are two options for packet format; standard bits mode and
floating point mode.

Packet
Format

Data Bytes
Used

Data Description

Floating
Point

4
Data sent in engineering units selected during
channel configuration using applicable
conversion values and formula.

Standard
Bits

2

Data sent in digital bit format (A to D values),
units conversion coefficients applied during post
processing. Uses half the bandwidth of floating
point mode and is recommended for high sample
rate or data intensive applications.

Table 6 - Packet Formats

g. Beacon Lost Timeout: sets what the node will do when the beacon is lost. If
enabled, the node will go into a low-power state when the beacon has been lost and
the timeout period expired. While in this state it will periodically (every 2 minutes)
check for the beacon. If found the node will resynchronized and resume sampling.

If not enabled, the node will continue sampling after the beacon is lost, and store the
data in a cache in node memory. When the cache is full, the oldest data will be
dropped and new data will take its place. Once the beacon is restored that data will
be transmitted oldest to newest.

h. Sampling Delay: To to save power, at sample rates under 32 Hz the node
automatically turns the sensor excitation off when not sampling. The sampling delay
is used in applications where the sensor being sampled requires a warm-up period
before the sample is taken. The delay sets the time that the node excitation voltage
will be turned on before the sample is taken. With sample rates higher than 32 Hz
the excitation voltage is always be on and this setting is not applicable.
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9.1.1 Using the Beacon

Nodesmust be on the same transmission frequency (channel) as the gateway to receive the
beacon broadcast command. When the beacon is active, the gateway device status
indicator will pulse blue once per second. When the nodes connected to the gateway are in
synchronized samplingmode, the network can be put to sleep by turning off the beacon and
then resuming transmitting once the beacon is enabled. Any node that is actively sampling in
synchronized sampling mode on the same frequency as the gateway will synchronize to it
automatically if the beacon is activated.

To avoid interference with other devices it is recommended that the beacon be disabled
when not in use. Do not operatemultiple gateways on the same frequency.

Alternately, the beacon can be activated from the synchronized sampling window when
sampling is started, and stopped with the stop node command which can be executed when
sampling is ended (see Synchronized Sampling Data Acquisition on page 101 and see
Ending Sampling Sessions on page 114).

9.1.2 Synchronized Sampling with Multiple Gateways

If synchronization is desired between gateways, it is recommended that a WSDA® -1500 -
LXRS® gateway be used because they can be configured to reference external time
sources and therefore get periodic same time updates. WSDA® -Base -10x -LXRS®

gateways do not have this feature and instead rely on the internal clock (which can vary
between gateways). For more information refer to theWSDA® -1500 - LXRS®User
Manual.



Node Commander® Software Suite UserManual SamplingModes

94

9.2 Low Duty Cycle

Low duty cycle (LDC) sampling is used for sampling at 512 Hz and below when low latency is
critical to the application. LDC mode utilizes carrier sense multiple access (CSMA) for
transmitted data collision avoidance. Data packet loss is still possible as the network size,
sampling frequencies, and packet size are increased. Packet loss statistics are available in the
data acquisition display (see Low Duty Cycle Data Sampling on page 106) and can be reduced
by optimizing the RF operating environment and conducting a range test (see Range Test on
page 56). Large networks can also be divided in to smaller networks operating on different
frequencies.

In LDC mode, many sample settings are user-adjustable. To adjust low duty sample settings,
open the node configuration menu by right clicking on the node name and then selecting
Configure > Configure Node. Select the Low Duty Cycle tab.

Figure 83 - Low Duty Cycle Settings

a. Sampling settings: The sampling can be set to repeat for a fixed interval of time
after the sampling has started, or continuously until a stop command is sent. Only
appropriate settings combinations will be available in the sampling settings
selections (per the node specifications and bandwidth limitations).
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b. Event Driven Sampling: the data will be continuously sampled but only recorded
when it meets the event criteria.See Event Driven Sampling on page 97.

When the Show AdvancedOptions check-box is selected several new menu options appear:

c. Action: configures the node to store sampled data in the nodememory (log), to log
the sampled data and transmit it to the gateway, or to only transmit it.

d. Packet Format: There are two options for packet format; standard bits mode and
floating point mode.

Packet
Format

Data Bytes
Used

Data Description

Floating
Point

4
Data sent in engineering units selected during
channel configuration using applicable
conversion values and formula.

Standard
Bits

2

Data sent in digital bit format (A to D values),
units conversion coefficients applied during post
processing. Uses half the bandwidth of floating
point mode and is recommended for high sample
rate or data intensive applications.

Table 7 - Packet Formats
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9.3 Datalogging

Use thismode when high sample rates are required, and immediate data access are not critical
to the application.

In datalogging mode, sampled readings are stored in the node memory instead of being
transmitted to the gateway during sampling. The sample rate is adjustable, and sampling can
be set to repeat for a fixed interval of time after the sampling has been started or continuously
until a stop command is sent. If the node is set to sample continuously, it will do so until the node
memory is full and then stop. The data is not transmitted to the gateway until the download
command is initiated from the gatewaymenu (see ArmedDatalogging on page 109).

To adjust datalogging settings, open the node configurationmenu by right clicking on the node
name and then selecting Configure > Configure Node. Select the Datalogging tab.

Figure 84 - Datalogging Settings
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9.4 Event Driven Sampling

Event driven sampling is available in both the low duty cycle and synchronized sampling
modes. In either mode the node is still taking continuous measurements based on the sample
rate and duration settings, however it only reports the measurement that meet the event
criteria. The node can be configured to also transmit the data just before and just after the
event. The pre and post event duration settings define the window of time before and after the
event that will be reported.

The event triggers are set for each channel in the form of a voltage threshold. The trigger
occurs when the channel reading is either above or below the threshold, depending on the
trigger operation settling.

The event driven sampling menus are accessed through the node configuration menu. Right
click on the node name and then select Configure > Configure Node. Select the desired
sampling mode (synchronized sampling or low duty cycle) and then select the Event Driven
Sampling check box, or the Configure button if the check box is already selected. The
Configure Event Driven Samplingmenuwill appear.

Figure 85 - Event Based Sampling Settings
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9.5 Streaming

In streamingmode, sample rates are automatic, based on the number of active channels. Table
8 - Streaming Sample Rates describes the automatic settings. Sampling can be set to repeat
for a fixed interval of time after the sampling has been started or continuously until a stop
command is sent. The data is transmitted continuously during sampling, and none is saved to
the nodememory. It is saved on the host computer in a data file.

Active
Channels

Sample Rate
(samples/sec)

1 736
2 679
3 617
4 565
5 520
6 485
7 452
8 424

Table 8 - Streaming Sample Rates

To adjust streaming sample settings, open the node configurationmenu by right clicking on the
node name and then selecting Configure > Configure Node. Select the Streaming tab.

Figure 86 - Streaming Settings
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9.6 Time Sources and Stamping

A time stamp is attached to the sensor data packets to indicate what time a sample was taken.
Each samplingmode handles time stamping differently.

Synchronized Sampling: Synchronized sampling has the most accurate sample timing
scheme. The time stamp is obtained from the host computer when sampling is started. Each
sample is then incrementally stamped from the precision real time clock inside the node (+/- 3
ppm) before it is sent to the gateway. As a result, node-to-node timing accuracy is guaranteed
to be within +/-32microseconds. For more information see Using the Beacon on page 93.

Low Duty Cycle: For sample rates under 1 Hz, samples are stampedwhen the data arrives at
the host computer after sampling and transmission. For sample rates over 1 Hz, a time stamp is
obtained from the host computer when sampling is started, and the time stamp for each
subsequent sample is then calculated from the sample rate.

Datalogging: A time stamp is obtained from the host computer when sampling is started. The
time stamp for each subsequent sample is then calculated from the sample rate.

Streaming:No time stamp is used in streamingmode.

NOTE

Absolute time accuracy of timestamps are dependent on the accuracy of the time on
the host computer at the initialization. For applications that require absolute accuracy,
use the network-readyWSDA® -1500 - LXRS® gateway for data acquisition, as there
are several time source options that are available . They include using network-based
time servers, manual user entry, or an attached Global Positioning System (GPS)
device. Refer to theWSDA® -1500 - LXRS®User Manual for details.
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10. Data Acquisition

During data acquisition, one sampling mode is chosen for each node. Nodes connected to the
same gateway can sample in different modes, however each node can only run one sampling
mode at a time. The sampling settings for the node will be applied to all channels. See Sampling
Modes on page 87 for information about the sampling settings.

Nodes can continue to sample even without Node Commander® running or actively displaying
data.See Ending Sampling Sessions on page 114.

All modes automatically save data to the host computer.See Sensor Data Files on page 117.

NOTE

Once sampling has started it will continue as configured without the need to leave
Node Commander open. However, if the node is powered off and is not configured to
sample on boot- up, data acquisition will end and must be restarted in Node
Commander. To resume viewing data acquisition after the sampling window has
been closed, useMonitor Mode (found in the gatewaymenu).

NOTE

A maximum file space allocation is set in Node Commander to avoid filling the data
acquisition computer's memory in high sample rate or otherwise data intensive
applications. Once the limit is reached data will no longer be saved on the computer.
See Software Preferences on page 12 . Alternatively, port data automatically to
SensorCloud™ with a WSDA® -1500 - LXRS® gateway for unlimited online cloud
storage (see Data Handling on page 23).

NOTE

Touching sensors and test boards or charging the node battery while acquiring data
may induce noise on sensitive sensor signals and is not recommended.
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10.1 Synchronized Sampling Data Acquisition

When data acquisition is started, each of the sampling modes has different menu options and
views. Some open a settings menu before data acquisition begins and may include a data list
view and/or a graph view. The following is an example of Synchronized Sampling (Figure 87 -
Starting a Sampling Session).

To start a sampling session, nodes can be selected individually or as a group. When selected
as a group, they will all be set to the same sampling mode. Right-click on the nodes and select
Sample > Synchronized Sampling.

Figure 87 - Starting a Sampling Session

When a synchronized sampling session is started, the sampling menu appears and includes
settings to enable optional sampling features, configure nodes, and to specify where the data
will be saved. The built-in bandwidth calculator displays the total bandwidth used by the nodes
selected for synchronized sampling (Figure 88 - Synchronized SamplingMenu).

a. Save Location: indicates where the data file will be saved on the host computer.
Use the Browse button to select a location.

b. Node configuration: includes the node serial number, sampling settings,
bandwidth calculation, and current status. Highlight any node or group of nodes,
and the Remove, Configure, and Refresh buttons become active. The Configure
button opens the node configuration menus to adjust settings as needed and
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recalculates the node bandwidth. Multiple nodes can be configured together by
using the Shift or Ctrl key to select them.

c. Lossless: enables the lossless data protocol. The protocol enables buffering and
retransmission of data in order to provide 100% data collection success. Using this
featuremay increase data display latency.

Figure 88 - Synchronized Sampling Menu

d. High Capacity: optimizes bandwidth and power use for nodeswith slower sample
rates by reducing the transmit rates. May increase data latency.

e. Network Bandwidth: is the total calculated bandwidth used by all the nodes. The
bandwidth changes as nodes are added, removed. and settings changed.

f. Enable Beacon on Start:When synchronized sampling is started the nodes wait
for the first beacon transmission to initiate sampling. When this option is selected
(default), the gateway beacon is enabled and will begin transmitting at a fixed
interval when sampling is started. Disabling the beacon on start (unchecking the
box) will set the nodes to wait for the beacon, but it does not actually start the
beacon when sampling is started. This can be used if there is a need for sampling to
be initiated later, or if the beacon is being received from another source than the
gateway. Enabling the beacon in this way is the same as enabling the beacon in the
gatewaymenu For more information see Using the Beacon on page 93.
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g. Apply settings and start sampling: Before acquisition can begin, use the Apply
Network Settings to save the session settings to the node. When completed, select
Start Sampling to begin.

h. Close sampling window (with the red "X") to exit sampling or, once the sampling
has been started, to view the data window behind it.

Synchronized sampling features two data views: Grid view and Graph view. Once sampling
has started, the data grid view is the default view (Figure 89 - Synchronized Sampling Data
View).

Figure 89 - Synchronized Sampling Data View

a. Device status: Node sampling mode and gateway status are displayed in
parentheses next to the device name.

b. Node information: includes node serial number and sampling statistics. Right-
click on the node name for moremenu options such as Stop Nodes.

c. Data: is a display of the sampled data with each channel in its own column.

d. Radio strength: indicates the strength of the communication between the gateway
and node.SeeRange Test on page 56.

e. Data file: the location and size of the data file, as data is added. View the data in
.CSV format with the Open File button.

f. View menu: Select between Data Grid andGraph views.

g. End sampling: The red "X" is used to exit the sampling window and/or end
sampling.See Ending Sampling Sessions on page 114.
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NOTE

When synchronized sampling is set to slower sample rates it may take several
seconds after sampling is initiated for the first sample to appear.

Use the view menu to select the Graph view of the data (see Synchronized Sampling Graph
View on page 104). Click on the node name to view the graph for that node. Click again to hide
it.

Figure 90 - Synchronized Sampling Graph View

a. Available Nodes: Click on the node to display the graph for that node. Click again
to hide it. Right-click on the node name for more menu options such as Stop Nodes
and Save Stream.

b. Axis range: Select the x-axis width and y-axis zoom percentage, or use the Auto
check box for automatic scaling.

c. Graph: The node graph shows the sampled data. Each active channel is displayed
in a different color. The x-axis is time in seconds and the y-axis is the A/D value
(bits). Right-click on the graph for additional menu options such as View Graph Key,
Pan, Zoom, Pause, and RemoveGraph.

d. View menu: Select between Data Grid andGraph views.
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e. Data file: The location and size of the data file as data is added. View the data in
.CSV format with the Open File button.

f. End sampling: The red "X" is used to exit the sampling window and/or end
sampling.See Ending Sampling Sessions on page 114.

NOTE

Once sampling has started it will continue as configured without the need to leave
Node Commander® open. However, if the node is powered off and is not configured
to sample on boot- up, data acquisition will end and must be restarted in Node
Commander®.
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10.2 Low Duty Cycle Data Sampling

To start a sampling session, nodes can be selected individually or as a group. When selected
as a group, they will all be set to the same sampling mode. Right-click on the nodes and select
Sample > Low Duty Cycle.

Figure 91 - Starting a Sampling Session

The Low Duty Cycle sampling window features two data views; a grid view and a graph view.
The data grid view is the default view when sampling is started. Figure 92 - Low Duty Cycle
Data Grid View shows the indicators and options in the grid view.
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Figure 92 - Low Duty Cycle Data Grid View

a. Device status: Node sampling mode and gateway status are displayed in
parentheses next to the device name. When the node is sampling, the gatewaywill
display "Monitoring", and the node will display "LDC" for Low Duty Cycle. Right-click
on the node name in this window to start a new sampling data file.

b. Node information: includes node serial number and sampling statistics. Right-
click on the node name in this window for moremenu options such as Stop Nodes.

c. Data: displays the sampled data; each channel is in a column

d. Radio strength: indicates how good the communication is between the gateway
and node. For more information see Range Test on page 56.

e. Data file: The location and size of the data file, as data is added. View the data in
CSV format with the Open File button.

f. View menu: Select between Data Grid andGraph views.

g. End sampling: The red "X" is used to exit the sampling window and/or end
sampling.See Ending Sampling Sessions on page 114
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Use the view menu to select the Graph view of the data (Figure 93 - Low Duty Cycle Graph
View). Click on the node name to view the graph for that node. Click again to hide it.

Figure 93 - Low Duty Cycle Graph View

a. Available nodes: Click on the node name to display the graph for that node. Click
again to hide it. Right-click on the node name for more menu options such as Stop
Nodes and Save Stream (saves current data).

b. Axis range: Select the X-axis width and Y-axis zoom percentage, or used the Auto
check box for automatic scaling.

c. Graph: The node graph shows the sampled data. Each active channel is displayed
as a different color. The X-axis is time in seconds and the Y-axis in the A/D value
(bits). Right click on the graph for additional menu options such as View Graph Key,
Pan, Zoom, Pause and RemoveGraph.

d. View menu: Select between Data Grid andGraph views.

e. Data file: The location and size of the data file as data is added. View the data in
CSV format with the Open File button.

f. End sampling:The red "X" is used to exit the sampling window and/or end
sampling.See Ending Sampling Sessions on page 114
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10.3 Armed Datalogging

Datalogging is initiated (armed) by opening a trigger session in Node Commander ® .
Datalogging settings are selected in the node configurationmenu and can vary between nodes
(see Datalogging on page 96).

1. Right click on one node or multiple node selections and select Sample > Datalogging
> Trigger Session or Trigger Datalogging, depending if there is one or multiple nodes
selected.

2. The selected nodes will appear in the Armed Datalogging window. The gateway will
send a Ping command to each node. The Status column will indicate if the ping was
successful, meaning the node is communicating with the gateway and ready for data
acquisition.

3. Enter a note for the data file, if desired.

4. Select Trigger All to begin data acquisition.

Figure 94 - Datalogging Menu
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5. The Progress column will indicate the percentage of sampling that has occurred.
When it reaches 100%, data acquisition is complete. At any time during the data
acquisition, one or all nodes can be stopped by selecting the Cancel Selected or
Broadcast Stop All button. This stops the data acquisition process and sets the node
back in idle. Alternatively, the Close button can be used to close the datalogging
window without ending the data acquisition. Data acquisition will continue until done
or until a stop command is sent to the node.

Figure 95 - Datalogging

NOTE

Depending on datalogging settings for each node, data acquisition may take
longer to complete on some nodes than others. The Close button can be used
to close the datalogging window without stopping the data acquisition. The
Close Selected or Broadcast Stop All buttons are used to stop data acquisition
on one, or all nodes.
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6. Once the datalogging menu is closed, the nodes that have acquired data will
automatically display the node information in the Controller window. The Memory
Percent Full indicates the percentage of memory that has been used for datalogging.
Number of Triggers indicates how many datalogging files have been created.

Figure 96 - Node Memory Statistics

7. To download the datalogging files off of the node onto the host computer, right click
on a node name, or group of nodes, and select either Sample > Datalogging >
Download or Sample > Download Triggers.

8. In the Download Triggersmenu, select the node or nodes, and the Start Download
button.

Figure 97 - Datalogging File Download
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The data that is stored in the node memory can be erased from the download window or
from the node menu. The erase selection is only available in the nodemenu when selecting
just one node at a time. Right click on the node name, and select Sample > Datalogging >
Erase.

Figure 98 - Erase Node Memory

Data can be viewed from the download window, or from the node menu. The view triggers
selection is only available in the node menu when selecting just one node at a time. Right
click on the node name, and select Sample > Datalogging > Browse Triggers. Browse to the
desired files to open. The data files are in CSV format.

Figure 99 - View Downloaded Data
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10.4 Streaming Data

Streamingmay only be initiated on one node at a time. To start a streaming data session, right
click on the node name in the Controller window and select Sample > Stream > Start. The
Resyncmenu option is used to resume viewing a streaming session that is already running.

Figure 100 - Streaming Data Graph

a. Node information: displays the node serial number, frequency,and
communications port.

b. Axis range: select the X-axis width and Y-axis zoom percentage, or used the Auto
check box for automatic scaling.

c. Graph: the node graph shows the sampled data. Each active channel is displayed
as a different color. The X-axis is time in seconds and the Y-axis in the A/D value
(bits). Right click on the graph for additional menu options such as show key, pan,
zoom, and stop streaming.

d. End sampling: the red "X" is used to exit the sampling window and/or end
sampling.See Ending Sampling Sessions on page 114.
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10.5 Ending Sampling Sessions

There are multiple ways to end sampling sessions. Some end the session and stop the
sampling, while other methods just end the session and allow the node to continue sampling.

1. Exit the data view window:Click the red "X" in the upper right of the data sampling or
datalogging window. This option is used to continue sampling after Node Commander®

is closed, or to end sampling.

Figure 101 - Ending a Sampling Session

When exiting the sampling session in this way, data acquisition can be stopped, or continue
after the data view is closed.

Figure 102 - Stop Nodes or Continue Sampling
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2. Stop the nodes during sampling: In modeswith data grid and graph views, right click in
the data sampling window, or on the node name to display amenuwith the Stop All Nodes
or Stop Streaming command. In dataloggingmode there is a Stop Broadcast button. This
ends all data acquisition.

Figure 103 - Stop All Nodes

3. Use the stop node command: If the node is sampling without an active view of the data
acquisition, right click on the node name in the Controller window and select the Stop Node
Command to end sampling. This ends data acquisition for the selected node.

Figure 104 - Stop Single Node
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10.6 Monitor Mode

Monitor mode is used to observe any low duty cycle and synchronized sampling activity that is
occurring on nodes connected to a particular gateway. When monitor mode is selected, the
sampling window opens and displays the data. This is useful if the node was configured to start
sampling on boot up or if the data acquisition screen was closed without stopping the node. It is
a way to enter the data and graph view windows after data acquisition has already begun. The
gateway will only monitor nodes that are on the same frequency (channel) that it is on. All
nodes on that frequencywill automatically be displayed.

Tomonitor a node, right click on the gateway name and select Monitor Mode.

Figure 105 - Monitor Mode
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10.6.1 Sensor Data Files

Data acquired in Node Commander is stored in .CSV format and can be opened with
Microsoft Excel, Quattro Pro, Open Office, or another CSV editors/spreadsheet program. 
Data in this format is easily uploaded to SensorCloud™ using the CSV Uploader. The data
files can be found on the host computer in the default directory or the location specified at
the beginning of the sampling session (as applicable). The files are organized in separate
folders bymode and then further categorized by date, session, and/or node serial number. 

The default directory is:C:\ProgramData\Microstrain\NodeCommander\Data

Synchronized sampling and low duty cycle files are found in the Sampled Data folder,
and streaming data is stored in the Streaming folder. Datalogging files need to be
downloaded from the node to be available for viewing. They are accessed through
datalogging menus as well as the File menu, and are saved in the Downloaded Triggers
folder.

Figure 106 - Exploring Data

NOTE

The Microsoft Excel the Time data column in the data file may have to be
changed to "m/d/yyyy h:mm:ss:000" format to make it more readable.
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11. Support

11.1 Troubleshooting Guide
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Problem Possible cause and recommended solution

1. POWER

gateway or node does
not turn on, or node
does not charge

1.1 node or gateway power is off

The status indicator LED on the device may be off.  Turn the
device on, and the status indicator LED should illuminate.

1.2 external power is off or miswired

Verify the device power source is connected correctly and
powered on.

1.3 wrong power supply

Using a power supply other than the one specified for the device
(or an external supply that is outside of the device operating
range) could result in permanent damage to the device or cause
it to not work properly.

1.4 node internal source select switch is incorrect

When the node is manufactured, it is set to internal battery
operation, but it can be configured to accept an external source.
When set to accommodate an external source, the battery
cannot be charged.

1.5 node battery is dead

If the node power source selector is set to internal, and the node
will not power on or charge, the node battery may need to be
replaced. Contact LORD MicroStrain® Technical Support (See
Technical Support on page 127).

1.6 node battery fault

If the battery charge indicator on the node is only dimly
illuminated when charging is attempted, a battery fault condition
has occurred. Unplug power, and then plug it back in. The
indicator should turn on brightly, indicating charging.

1.7 sensors are drawing too much current

The node battery can only supply a limited amount of power to
the connected sensors.  If an over-current condition occurs, the
node will shut down.  Consider powering the node or sensors
with an external source. 
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Problem Possible cause and recommended solution

1.8 node or gateway is damaged

If all power settings and connections have been verified, and the
node is still unresponsive, contact LORD MicroStrain ®

Technical Support (See Technical Support on page 127).

2. COMMUNICATION

no communication to
the gateway or node

2.1 node or gateway has no power

Verify the node and gateway have power applied and that
applicable power switches are on.  Power is indicated on both
devices by a status indicator LED.

2.2 gateway has no communication with the computer

Verify gateway communication in the software. Check, remove,
and reconnect communications and power cables as applicable. 

l For serial gateways, verify that the COMport setting.

l For USB gateways, verify that the drivers are installed on the
computer (included with Node Commander®) and that the
software has had sufficient time to detect it.

l For Ethernet gateways, use Live Connect™ to verify
communications on a DHCP network. Check that the
extended timeouts are enabled in the Node Commander®

Edit > Preferencesmenu, under Devices. Once
communication has been established, the network
configuration can be changed.

2.3 node cannot be configured

Observe the node status indicator LED to determine the
device's state: boot, idle, sample, or sleep. If the node is
sampling or sleeping, it cannot be configured. In Node
Commander®, execute the Stop Node command to put the
node in idle state, allowing configuration to occur.

If the user inactivity timeout is set very low, the configuration
menuwill have to be entered quickly, before the timeout occurs,
putting the node back in a sample or sleep state.
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Problem Possible cause and recommended solution

2.4 node is out of range

Perform a bench test with the node in close proximity to the
gateway to verify they are operational.  For range test and
installation recommendations see Range Test on page 56.  The
system has been tested to operate with the node and gateway
up to 2 km apart with clear line of sight.

2.5 node is not in normal boot mode

If the node status indicator shows the node booting in a mode
other than the normal boot mode, it can be bypassed by toggling
the node ON/OFF switch rapidly three times, then leaving it in
the ON position for normal power up. In normal boot mode the
communication can be established with automatic node
discovery (or manually) once the boot process is complete and
the node is in idle state. Start-up mode can then be changed in
the software.

2.6 node is sampling

Observe the node status indicator LED to determine the
device's state: boot, idle, sample, or sleep. If the node is
sampling, it cannot be configured. In Node Commander® ,
execute the Stop Node command to put the node in idle state,
allowing configuration to occur.

2.7 node is sleeping

Observe the node status indicator LED to determine what state
it is: boot, idle, sample, or sleep. If the node is sleeping, it cannot
be configured. In Node Commander®, execute the Stop Node
command to put the node in idle state, allowing configuration to
occur.

2.8 gateway or node is damaged

Verify all connections, power, and settings.  If available, try
installing alternate nodes and gateways one at a time to see if
the faulty device can be identified.  If no conclusion can be
determined or to send a device in for repair, contact LORD
MicroStrain® Technical Support (See Technical Support on
page 127).

3.1 no communication to node or gateway
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Problem Possible cause and recommended solution
3. DATA ACQUISITION

sensor data is missing
or incorrect

Verify connections and power to the node and gateway. Verify
they are powered on and communicating with the software.
Enter a configurationmenu to verify that the node can be
accessed.

3.2 sampling settings are incorrect

If the sampling mode, rate, or duration are not performing as
expected, enter the node configuration menu, and verify the
sampling settings.

3.3 sampling has not started

If sampling is occurring, the sampling mode will be displayed
next to the node name in Node Commander®. The node device
status indicator will also be flashing the sampling mode code. If
the node is not sampling, activate it in the software or with a
sample on start up boot sequence.

3.4 sensor is not connected correctly

Verify sensors connections and wiring.  For non- standard
connections contact LORD MicroStrain® Technical Support
(See Technical Support on page 127).
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11.2 Communications Ports in Windows®

Serial gateways (including USB gateways) have either a standard serial or virtual
communications port inWindows®. Windows®DeviceManage can be used to determine what
communication port the gateway is connected to.

1. Click on theWindows® Start icon, and select Control Panel.

2. Navigate to the System menu, and select Device Manger. The menus may appear
different depending on the version ofWindows and the View settings.

Figure 107 -Windows® System Menu
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3. In DeviceManager, expand the view for Ports (COMand LPT). Active COMports will
appear on this list with the COM port number. A USB gateway will be displayed as
USB to UART Bridge (COM X ). A serial gateway will be attached to the
Communications Port (COMX). An Ethernet gateway will be connected to a Virtual
Serial port (COMX). If no port is listed, the port is not recognized by the computer, and
no gateway communication can be established.

Figure 108 - Windows® Device Manger Menu

4. To view the port settings, select the device, right click on it, and select Properties.
Table 9 - Serial Port Settings, describes the settings for serial communication. The
baud rate for the RS232 gateway can be adjusted in Node Commander® only.
Changing it in the Windows port settings menu will not work. See Setting the Serial
Baud Rate on page 39. USB gateways run only at 921,600 baud. 

Port Setting Value

Baud Rate
115,200 (RS232 gateways) or

921,600*

Parity none

Data Bits 8

Stop Bits 1

* for RS232 gateways, see Setting the Serial Baud Rate on page 39.

Table 9 - Serial Port Settings
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11.3 Live Connect™ Interface

Live Connect™ is a bridge between Ethernet gateways, Node Commander® , and the LORD
MicroStrain®web based SensorCloud™ data aggregation and data visualization software.

See Gateway Ethernet Communications on page 32 for information on connecting to the
Ethernet gateway in Node Commander® . Once communication is established, data files
created in Node Commander ® can be uploaded to SensorCloud™ through the Node
Commander® File menu.

Live Connect™ also provides access to the Ethernet gateway configuration Control Panel.
Refer to the gateway user manual for more information (see Reference Information on page
130).
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11.4 WSDA® Data Downloader

The WSDA® Data Downloader is included with the Node Commander® Software Suite and
allows the user to download sensor data stored in the WSDA® - 1500 - LXRS® gateway
memory to a host computer. The data will be in CSV format. Only the sensor channels selected
will be downloaded into the CSV file. Data can also be erased from the gatewaymemory in this
menu.

Open the WSDA® Data Downloader by running it from the Windows® Start menu. Enter the
gateway IP address and log-in information. The IP address can be determined in Live
Connect™, and the log-in credentials are the same as for logging into the gateway Control
Panel (refer to theWSDA® -1500 - LXRS® user manual).

The WSDA® Data Downloader has four main features; the ability to select and download
sensor data, apply calibration coefficients to the data prior to downloading, combine all
downloaded data into one file, and clear the data from the gateway memory (Figure 109 -
WSDA® Data Downloader). How long it takes to download depends on the amount of data
selected.

Figure 109 - WSDA® Data Downloader
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11.5 Software Specifications

Parameter Specification

Software Name NodeCommander® , Live Connect™, andWSDA® Data Downloader

Operating Systems MicrosoftWindows® XPPro, Vista, and 7, 32/64-bit

Computer Requirements
1GHzprocessor, 256MBmemory, 50MB free hard drive space for the application,
32MB video card, 800 x600 video resolution

For Use With
All LORDMicroStrain®LXRS®, mXRS™and legacy2.4Ghzwireless sensors nodes
and gateways.

11.6 Technical Support

There are many resources for product support found on the LORD MicroStrain® website,
including technical notes, FAQs, and product manuals.

http://www.microstrain.com/support_overview.aspx

For further assistance our technical support engineers are available to help with technical and
applications questions.

Technical Support

sensing_support@LORD.com

Phone: 802-862-6629
Fax: 802-863-4093

SKYPE:microstrain.wireless.support

Live Chat is available from the website during business hours:
9:00 AM to 5:00 PM (Eastern TimeUS & Canada)

http://www.microstrain.com/wireless
mailto:sensing_support@LORD.com


Node Commander® Software Suite UserManual Support

128

11.7 Wireless System Equipment

Model Description
LORD

MicroStrain®

Part Number
WSDA-1500-SK Ethernet Data GatewayStarter Kit 6314-1501

--
SensorCloud™ Software Subscription
(contact LORD MicroStrain® Sales)

--

WSDA-BASE-104-SK USB GatewayStarter Kit 6307-1041
WSDA-BASE-102-SK RS232GatewayStarter Kit. 6307-1021
WSDA-BASE-101-SK AnalogGatewayStarter Kit 6307-1011

-- Replacement USB cable 9022-0029
-- USB Gateway cable extender 6307-0900
-- Replacement serial cable 4005-0005

WSDA-1500 Ethernet Data Gateway 6314-1500
WSDA-BASE-104 USB Gateway 6307-1040
WSDA-BASE-102 RS232 Serial Output Gateway 6307-1020
WSDA-BASE-101 AnalogOutput Gateway 6307-1010
G-Link-LXRS Wireless Accelerometer Node various models
G-Link2-LXRS Wireless Accelerometer Node various models
SG-Link-LXRS Wireless 2-Channel Analog Input Sensor Node various models
SG-Link-OEM Wireless 2-Channel Analog Input Sensor Node various models
SG-Link-RGD RuggedizedWireless Analog Sensor Input Node various models
V-Link-LXRS Wireless 7-Channel Analog Input Sensor Node various models
TC-Link-LXRS Wireless Thermocouple Node various models
DVRT-Link-LXRS WirelessDisplacement Sensor Node various models
ENV-Link-Pro Wireless Environmental Sensor Node various models
Watt-Link-LXRS Wireless EnergyMonitoring Sensor Node various models
RTD-Link-LXRS WirelessRTD Sensor Node various models
IEPE-Link -LXRS Wireless IEPE Accelerometer Node various models

Table 10 -Wireless System Equipment
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11.8 Product Ordering

Products can be ordered directly from the LORD MicroStrain® website by navigating to the
product page and using the Buy feature. 

http://www.microstrain.com/wireless

For further assistance, our sales team is available to help with product selection, ordering
options, and questions.

Sales Support

sensing_sales@LORD.com

Phone: 802-862-6629
Fax: 802-863-4093

9:00 AM to 5:00 PM (Eastern TimeUS & Canada)

http://www.microstrain.com/wireless
mailto:sensing_sales@LORD.com
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12. References

12.1 Reference Information

Many references are available on the LORD MicroStrain® website including product user
manuals, technical notes, and quick start guides. These documents are continuously updated,
and new applications are added. They may provide more accurate information than printed or
file copies. 

Document Where to find it

Online Wireless Network Calculator
http://www.microstrain.com/configure-your-

system
SensorCloud™
Overview

http://www.sensorcloud.com/system-
overview

MathEngine® Overview http://www.sensorcloud.com/mathengine
LORD MicroStrain®Wireless Sensors
Network Software Development Kit

http://www.microstrain.com/wireless/sdk

Product Datasheets http://www.microstrain.com/wireless/sensors
Product Manuals and Technical Notes http://www.microstrain.com/support/docs

Product Application Notes http://www.microstrain.com/applications
NIST Calibration Procedures http://www.nist.gov/calibrations/

ASTM Testing Procedures
http://www.astm.org/Standard/standards-

and-publications.html

Table 11 - Related Documents

http://sensorcloud.com/pricing?showCalculator=true
http://sensorcloud.com/pricing?showCalculator=true
http://www.sensorcloud.com/system-overview
http://www.sensorcloud.com/system-overview
http://www.sensorcloud.com/mathengine
http://www.microstrain.com/wireless/sdk
http://www.microstrain.com/wireless/sensors
http://www.microstrain.com/support/docs
http://www.microstrain.com/applications
http://www.nist.gov/calibrations/
http://www.astm.org/Standard/standards-and-publications.html
http://www.astm.org/Standard/standards-and-publications.html
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12.2 Glossary

These terms are in common use throughout themanual:

A/D Value: the digital representation of the analog voltages in an analog- to- digital (A/D)
conversion. The accuracy of the conversion is dependent on the resolution of the system
electronics; higher resolution produces amore accurate conversion. Also referred to as "bits".

ASTM: The Association of Standards and Testing is a nationally-accepted organization for the
testing and calibration of technological devices.

Base Station: The base station is the transceiver that attaches to the host computer and
provides communication between the software and the node(s). It is also referred to as a
“gateway”.

Bits: the digital equivalent of voltage on the node. See 'A/D Value'.

Burst Sampling: amode of operation in which the node is sampled for a fixed window of time
(burst), and then repeats that window at set intervals. The burst duration and time between
bursts is configurable. Same as periodic burst sampling.

Calibration: to standardize a measurement by determining the deviation standard and
applying a correction (or calibration) factor

Configuration: a general term applied to the node indicating how it is set up for data
acquisition.  It includes settings such as sampling mode and rate, number of active channels,
channel measurement settings, offsets, hardware gain, and calibration values. 

Continuous Sampling: a mode of operation in which the node is sampled continuously until
stopped, or continuously for a fixed amount of time.

Coordinated Universal Time (UTC): the primary time standard for world clocks and time. It
is similar to GreenwichMean Time (GMT).

Cycle Power: a command transmitted to the node to reboot it, either through a hardware or
software switch

Data Acquisition: the process of collecting data from sensors and other devices

Data Logging: the process of saving acquired data to the system memory, either locally on
the node or remotely on the host computer
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DHCP (network): Dynamic Host Configuration Protocol is the standardized networking
protocol used on Internet Protocol (IP) networks, which automatically configures devices that
are attached to it by assigning and configuring the device IP address.

Differential (signal): is a method of transmitting electrical signals in which they are paired
together as a differential pair and measured with reference to each other only.  This method
makes the pair less susceptible to electrical noise.

EMI: Electromagnetic Interference is an inductive or radiated disturbance that can create
signal degradation on electrical signals, including loss of data.

ESD: Electrostatic Discharge is the sudden flow of electricity that can occur between two
charged objects of different potential that come in contact or in close proximity of each other.
Static electricity is a common source of ESD.

Event-Based Sampling: a mode of operation in which the node sampling is started when a
sensor measurement value (threshold) is achieved.

Firmware: the code that is programmed onto a microcontroller or similar device in an
embedded system. It includes device operation commands, conditions, memory allocation, and
many other tasks. 

Gateway: The gateway is a transceiver that attaches to the host computer and provides
communication between the software and the node(s). It is also known as a “base station”.

Host (computer): The host computer is the computer that orchestrates command and control
of the attached devices or networks.

LED: Light Emitting Diode is an indicator light that is used in electronic equipment.

LOS (Line of Sight): is used in radio communications to describe the ideal condition between
transmitting and receiving antennas in a radio network. As stated, it means the antennas are in
view of each other with no obstructions.

LXRS®:Lossless Extended Range Synchronized is the proprietary LORD MicroStrain® data
communications protocol used in the wireless sensor network.

NIST: TheNational Institute of Standards and Testing is a nationally-accepted organization for
testing and calibration of technological devices.



Node Commander® Software Suite UserManual References

133

Node: The node is the wireless transceiver that the sensor (s) is connected to, providing
communication with the gateway.  The G-Link® -LXRS®, V-Link® -LXRS®, and SG-Link® -
LXRS® are examples of nodesmanufactured by LORD MicroStrain®.

Node Tester board: TheNode Tester board is a device designed by LORD MicroStrain® that
can be plugged into nodes to test their functionality.

Offset: When describing amathematically-linear relationship, the offset is the value where the
line that represents the relationship in a graph crosses the y-axis.  The equation of a straight
line is: y = mx+b, where x is the x-axis coordinate, y is the y-axis coordinate,m is the slope and
b is the offset.

Oversampling: In signal processing, oversampling is a technique used to achieve increased
signal resolution and better noise immunity by recording readings at a higher frequency than
the output of the device being measured. In analog- to- digital conversion, the higher the
oversampling rate, the better the recreated analog signal.

Packet: unit of sampled data

Periodic Burst Sampling: a mode of operation in which the node is sampled for a fixed
window of time (burst), and then repeats that window at set intervals. The burst duration and
time between bursts is configurable. Same as burst sampling.

Ping: a byte transmitted by the gateway to the node. The node responds by echoing the byte,
indicating communication exists between the node and gateway.

PGA: A Programmable Gain Amplifier is an electronic device used to amplify small electrical
signals.

Range Test: a continuous string of pings used to validate communication between the
gateway and the node over distance and obstruction

Read/Write EEPROM: commands transmitted to the node to read or write parameters stored
in the node’s operating system

Real Time Clock (RTC): a computer clock that keeps track of the current time

Resolution: in digital systems, the resolution is the number of bits or values available to
represent analog values or information. For example, a 12-bit system has 4,096 bits of
resolution and a 16-bit system has 65,536 bits.
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RFI: Radio Frequency Interference is a disturbance in an electrical circuit due to
electromagnetic induction or radiation.

RSSI: Received Signal Strength Indication is a measurement of the transmission power in a
radio signal. It ismeasured in decibels with reference to 1milliWatt (dBm).

RS232: a serial data communications protocol

Sensor: a device that physically or chemically reacts to environmental forces and conditions,
producing a predictable electrical signal

Sleep: a command transmitted to the node to put it into sleep configuration

Sampling: the process of takingmeasurements from a sensor or device

Sampling Mode: the type of sampling that is being utilized, such as event- triggered,
continuous, or periodic. The nodes have several samplingmodes that employ these types of
sampling.

Sampling Rate: the frequency of sampling

Single Ended: electrical signals that aremeasured with reference to a system ground

Slope:When describing amathematically linear relationship, the slope is the steepness of the
line that represents that relationship on a graph.  The equation of a straight line is: y = mx+b,
where x is the x-axis coordinate, y is the y-axis coordinate,m is the slope, and b is the offset.

Streaming: Streaming is a sampling mode in which all active channels (and the sensors
attached to them) are measured, and the acquired data is transmitted to the gateway and
software. The data is not written to non- volatile memory during streaming.  Streaming can
either be finite (have a user defined start and end time) or continuous (continued until the power
is cycled on the node).

Synchronized Sampling: a sampling mode that automatically coordinates all incoming node
data to a particular gateway. Thismode is designed to ensure data arrival and sequence.

Transmission rate: the number of data packets per transmission window, measured in
seconds. Depending on the samplingmode and settings it will be between 1 and 64
packets/second.

Transmission window: the time allowed for one data transmission at the automatically
determined transmission rate
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USB:Universal Serial Bus, a serial data communications protocol

Wheatstone Bridge: an electrical circuit used tomeasure unknown electrical resistances 

WSN: Wireless Sensor Network describes a distribution of sensors and data acquisition
equipment that autonomously monitors environmental characteristics, such as temperature,
pressure, and strain.
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